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Mixbus - Bringing real console mixing to the DAW

Welcome to Mixbus!  Mixbus is an “analog console” that has been incorporated into a Digital Audio Workstation.  The
Mixbus engine was developed in-house at Harrison Consoles, where we have been designing high-end digital and
analog consoles for over 30 years.  Many influential works such as Michael Jackson's Thriller (the best-selling album
of all time) were recorded and/or mixed on Harrison consoles.  Harrison continues to be a major force in the ultra-
high-end professional audio community.  World-class film, post and music facilities use Harrison consoles.  For more
information about Harrison, visit our website at http://www.harrisonconsoles.com.

This document describes the Mixbus “analog console” which Harrison developed for the Ardour DAW.  It assumes
that you are comfortable with typical Digital Audio Workstation (DAW) conventions and terminology, and Ardour in
particular.  For more general information about Ardour, please visit http://www.ardour.org.  Additional online resources
are available from the Mixbus Help menu.
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Mixer Features:
•  Precision DSP algorithms developed by Harrison and used on their world-renowned large format digital mixing 
consoles.  Mixbus also incorporates elements from the rich history of Harrison analog designs.  Mixbus has been
optimized to provide a classic Harrison “analog” sound. 
•  Straightforward “what you see is what you get” mixer layout based on Harrison's renowned 32-series and MR-
series music consoles.
•  Unlimited stereo or mono input channels (based on available CPU power) featuring EQ, filter, compression, 8
mix bus sends, and mappable plug-in controls on every channel.
•  8 Stereo mix buses (can be used for groups or auxes) featuring tone control, compression, and tape satura-
tion.
•  Stereo Master that features tone control, compression, tape saturation, and final limiting.
•  K-meter on master output helps you make dynamic, polished-sounding mixes.
•  Stereo phase correlation meter indicates mono-compatibility of your mix.
•  Plug-in delay compensation to support effects such as parallel compression.
•  Sidechain input on mix bus compressors.
•  Comprehensive metering with peak, peak hold, and compressor gain reduction visible on every track and bus.

Editor/DAW Features:
•  Every track/bus has unlimited pre- and post-fader inserts, sends, and plug-ins.
•  Non-destructive, non-linear editing with unlimited undo.
•  Fast and intuitive audio editing with “smart” mouse editing modes.
•  Dynamic automation of fader, pan, and plug-in parameters.
•  Pitch/time stretching, transient detection, and varispeed playback.
•  Object-oriented, per-region volume, dynamic volume, crossfade in/out, and mute functions.
•  Standard file formats (BWF, WAV, WAV64, AIFF, CAF & more...)
•  Supports induystry-standard plugin formats and I/O devices on each supported platform.
•  Transport control via Level 2 MMC or MTC (master or slave)  ( currently OSX and Linux only )
•  MIDI CC control with 1 click  ( currently OSX and Linux only )

System Requirements:
•  OSX Intel or PPC Running 10.4.11 or newer
•  Windows XP Pro or newer
•  Linux system (x86 or x86-64) with working sound and JACK
•  Two or more processors/cores

See our website for the latest details on OS compatibility, plugin compatibility, and system requirements:

http://mixbus.harrisonconsoles.com
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Installation - Windows

Mixbus on Windows uses an industry-standard installation mechanism.  Follow the directions for a “Typical” install to
install Mixbus, the documentation, and any accompanying materials.

After installation, please continue to Download and Install the License File, on the following pages.

Uninstalling Mixbus:  use the uninstaller provided in the Windows Control Panel.

A note about JACK:
Jack is a system service that allows for the interconnection of audio between applications.  Your Mixbus installation
on Windows  does not require that you install JAC K separately.  A simplified JACK  (which is not visible to other
applications) is automatically installed when you install Mixbus.

If you would like to interconnect the audio of different applications into Mixbus, then you can download and install a
system-wide version of JACK.  This is not endorsed or supported by Harrison at this time.

A note about “Audio Setup” on Windows:
On Windows, Mixbus will detect soundcards that use the DirectSound or ASIO API.  This means that you will likely
see soundcards appear multiple times in the audio setup menus.  If provided, the ASIO driver option is preferable for
stable, low-latency operation.

Many built-in desktop sound devices will not provide an “Input device” if a microphone is not physically plugged in.  If
you plan to record with Mixbus, you must plug a device into the soundcard’s input _before_ you launch the audio
engine.  If you’d like to use Mixbus without a capture device, choose “None” for the Input device.  Mixbus does not
provide a “None” option for the playback device. If you have no devices for playback then you can choose the
Dummy device which runs Mixbus without any sound I/O.

When you select an ASIO device, the “Buffer size” setting will be automatically changed to the current preferred
buffersize of your ASIO device (normally set in the device’s manufacturer-supplied control panel). It is important to
use the device’s preferred buffersize.  Otherwise you will incur a “buffersize adaptation” process which reduces effi-
ciency and may affect latency (delay) through Mixbus.

Non-ASIO devices will default to a buffersize of 1024 for stable operation.  Changing this setting is possible but is
unlikely to have much effect on the performance because of the Windows sound infrastructure.

A note about VST plugins on Windows:
On Windows, Mixbus will load and use VST plugins. Please note that we cannot guarantee that all 3rd party plugins
will work properly in Mixbus.  Mixbus is (currently)  a 32-bit only application on Windows, so it can only load 32-bit
VST plugins.

When you launch the Plugin Manager for the first time, Mixbus will prompt you to scan for VST plugins.  This process
can take several minutes if you have many plugins.  If the scan completes succesfully, then Mixbus will auto-scan for
plugins when it starts up in the future.  This process is much faster than the initial scan.

If a plugin causes Mixbus to crash during the “scan” procedure, then this plugin will be placed on a “blacklist” which
prevents that version of the plugin from loading in the future.

Please see the Preferences->Plugin dialog for more information about VST plugins.
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Installation - OSX
Because Mixbus is a professional product which is intended to be interconnected with other professional products, it
requires attention to your system setup before it is ready for use.

Installing JACK:
Before running Mixbus, you must install the Jack package.  Jack is a system service that allows for the interconnec-
tion of audio between applications.  For example, you can use Jack to record the output of Apple LogicTM directly into
a Mixbus track for live processing or recording.  Mixbus requires that Jack be installed.

Jack is included in your Mixbus application download.  If you already have Jack
installed on your system, then you can skip the first step of the installer.

Double-click the appropriate version of Jack to install for your system.

As part of the installation process, you will need to provide the Administrator
password for your Mac – enter it and click OK.

When updating to a new version of Jack, you should first uninstall the previous
version using the uninstaller in Applications/Jack.  You can also find additional
Jack documentation in this folder.

You can download new versions of Jack, or learn more about it at:
http://www.jackosx.com

Installing Mixbus:
To install Mixbus, simply drag the Mixbus icon to the Applications folder.  If you would like Mixbus to be shown in the
Dock, then you should open the Applications folder and drag Mixbus to the Dock.

Audio Input and Output, and “Aggregate” devices:
Mixbus is designed to work with professional I/O cards connected via USB, Firewire, or PCI cards.  If you are using
the internal soundcard on an Intel Mac, you must first create an Aggregate Device which combines the internal
microphone and the internal speakers into a single I/O device.  While these directions are slightly different for each
Apple product, you can follow the directions on the Apple website.

OS X 10.5: http://support.apple.com/kb/HT1215
OS X 10.6:  http://support.apple.com/kb/HT3956

Aggregate devices also provide a method to use multiple soundcards as a single device.  For example, you can
"aggregate" 2 different 8-channel devices so that you can record 16 channels into Mixbus.

Continue to Download and Install the License File, on the following pages.
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Note: The first time you launch Mixbus, it may take several seconds while it caches the available fonts and
plug-ins.  After this initial instance, future launches will be much faster.

%

Note: PowerPC (G4 and G5) users who wish to use the built-in soundcard do not have to create an aggre-
gate device.  Users with external soundcards (USB, firewire, PCI, etc) do not have to create an aggregate

device.

%

Note: Once installed, you do NOT have to use the included Jack control application (JackPilot).  Mixbus can
control Jack directly via the Audio Setup tab.

%



Installation - Linux
A note about Linux distributions:
While an expert system administrator can adapt nearly any distribution for use with Mixbus, it is easier for most users
to start with a distro that is designed for use in high-performance audio.

Some distributions that are designed for audio include AVLinux, UbuntuStudio, and 64Studio.  Mixbus has been test-
ed on these distributions as well as vanilla Ubuntu and Fedora.  A further list of distributions is at: http://www.linux-
sound.org/distro.html.  It is beyond the scope of this document to compare these distributions.

Soundcard (I/O) support:
Support for professional sound I/O is limited on Linux.  However there are some excellent options available at vari-
ous price ranges.  Normally, no driver or configuration is needed to use a soundcard if it is supported by your distri-
bution.  It is important to choose a distribution that has good pro-audio support.

Unfortunately, support must be determined on a per-device basis.  The ALSA project provides a fairly comprehensive
list of USB, PCI, and built-in devices.  There is a separate list of Firewire devices.  When in doubt, check with your
distribution's documentation, user forums, or support.

Installing JACK:
Before running Mixbus, you must have Jack installed.  Jack is a system service that allows for the interconnection of
audio between applications.  For example, you can use Jack to record the output of the Hydrogen drum machine
directly into a Mixbus track for live processing or recording.  Mixbus requires that Jack be installed.

Your Linux distribution must include support for realtime Jack and associated audio I/O hardware.  Please verify that
your underlying audio system is appropriate for professional audio usage before purchasing Mixbus.

Many modern distributions include a “package manager” utility for installing software from an online repository.  JACK
can often be installed directly from this utility.

Downloading and Installing Mixbus:
After your purchase, you will receive a link to download the installation package.

You must first unzip the package using your distributions archive utility.  Most distributions will allow you to unzip the
file by right-clicking on it, and choosing “extract here”.

Once unzipped, a folder will appear with the installer (install.sh).  In most distributions, you can double-click this file
to launch it directly.  If this does not work, then use a Terminal window to “cd” to the folder and execute the script
manually.

The installer will detect your system type (32- or 64-bit) and install the correct version of Mixbus, as well as install
any needed menu and desktop links to Mixbus.  Finally, the installer will check the suitability of your system for real-
time audio, and report any problems that it finds.

Continue to Download and Install the License File, on the next page.
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Installation – All Platforms

Download and Install the License file:
When you complete your purchase through the Mixbus store, you should receive an email with a download link for
your license key.

Please download the file and save it to your Desktop  (the Home folder and Downloads folder will work, too).  When
launched, Mixbus will find the license file and convert it to a hidden file in your home folder.

The license file is used to display your name in the New Session dialog when Mixbus launches.  If Mixbus reports
that your copy is  UNLICENSED, please contact Harrison for support.

Unlicensed copies of Mixbus will generate occasional noise (hiss) from each track.  Additional tracks will increase the
volume of this noise.

33..00  IInnssttaallllaattiioonn
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Getting Started
When Mixbus is first started, you will be presented with the “Audio Setup” dialog.  On future launches, you will be
presented with 3 tabs in the New Session Dialog:

How does audio I/O work in Mixbus, and what is JACK?
Jack is a very advanced program that “lives” in-between your soundcard driver and your audio applications.  Jack
allows you to route the inputs and outputs of Mixbus into your soundcard.  It also allows you to route the audio inputs
and outputs of your other applications to each other and to Mixbus.

One thing to know about Jack:  because of its “special” position between your soundcard and other audio software, it
runs at a fixed sample rate once it is started.  If you want to run a session at a different sample rate, you must first
stop, change the settings, and restart Jack.

Most users will ignore JACK, and allow Mixbus to start and stop Jack for you.  Mixbus will prompt you for the Jack
settings when it starts in the Audio Setup tab.  Mixbus will automatically stop Jack when you quit Mixbus.  Mixbus will
also remember your settings for you. Note, however, that Mixbus does not stop Jack when a session is “Closed”.

Instead, you must completely “Quit” Mixbus and restart it if you want to open a session at a
different sample rate.

Creating Tracks for recording
When you are ready to record, you must create tracks.  Use the “Add Track/Bus” function
which can be found in the Session and Track menus.  You can also create tracks by right-
clicking in the grey track area under the track headers, or by Importing new tracks from exist-
ing audio files.

You can create as many tracks as needed.  Mixbus supports Mono and Stereo tracks only.  If
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In the “New” tab, you can type the
name of a new session, choose a
folder location, and optionally
select a template as a starting
point.  Any session may be saved
as a “session template” which will
then be available as an option in
the template selector.

In the “Open” tab, you can select
any recently-opened session.
Double-click the session to open
the default session snapshot, or
use the triangle expanders to pick
a particular snapshot in the ses-
sion.  Use “Browse” to look for
sessions on your hard drive.

The Audio Setup tab selects the
soundcard interface, sample rate,
and buffer size for the session.

IMPORTANT NOTE: A session's sample rate is determined when it is created.  If you open a session with a
sample rate other than the rate the soundcard has been initialized with, Mixbus will alert you.  There are exter-

nal utilities available which can convert a session to a new sample rate, but this requires sample rate conversion
and may impart subtle artifacts into the recordings.  Music projects are typically created at 44.1kHz, while most
audio-for-video projects utilize 48kHz.

%



you have created some track templates, the templates will appear as additional choices in the “Channel
Configuration” menu.

Mixbus also allows the creation of busses which may be used to combine tracks together into groups for further pro-
cessing or utilitarian tasks such as headphone cue feeds.  Busses do not have the processing or delay compensa-
tion features of the Harrison Mix Bus Channels.  In general, the built-in Mixbus summing engine is sufficient for most
bussing needs.  But if your project is large enough to need additional bussing, they are available here.  

The “Tape” track mode creates tracks which may not be edited, and in which the underlying file is overwritten with
new data when recorded into (i.e. destructive recording). (NOTE:  due to the underlying file system, this feature is
not available on Windows)

Need Help?
Getting started with a new DAW can be a challenging task.  While Mixbus shares conventions with many other popu-
lar DAWs, it can still be a little difficult at the beginning.  Rest assured that it is worth your time and effort to learn
Mixbus.

For technical issues, bug reports, and feature requests, email support is available from Harrison Consoles:
mixbus@harrisonconsoles.com.

If you'd like to chat with other users of Mixbus, you can visit our internet chat area.  The easiest way to visit the chat
room is to select the Help->Chat menu option from Mixbus.  This will open your web browser to a page that allows
you to chat with other Mixbus users.  If you are unable to open the Mixbus window and see the “Chat” option, just
enter this URL directly into your web browser:  http://webchat.freenode.net/?channels=ardour-mixbus

Another mechanism for support is the Ardour forums at: http://www.ardour.org/forums This is a good place to get
involved with the open-source aspect of Mixbus; you can be directly involved with new features, bug fixes, and the
overall direction of the Ardour DAW.

"Once you have reached the level of a Harrison Console, you are ready for new flights of engineering imagi-
nation.  Unlimited.  Unhaltered.  Uninhibited by the bounds of technical obstructions.  YOU BECOME THE
STUDIO.  You are the living extension of the electronic link between the perfect sound and the perfect mas-
ter.  You are the ultimate conductor in the universe of recorded music" - Harrison 4032 brochure, circa 1975
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About JACK
Mixbus uses an internal audio routing system called "JACK" to make audio connections between Mixbus, your sound
I/O, other programs, and even between parts of Mixbus.  In many cases, you can use Mixbus without ever being
aware of JACK connections.  By default, Mixbus makes these connections:

•  The master bus is connected to the first two physical output ports.
•  Track/Bus inputs are assigned sequentially from the physical inputs whenever a new track/bus is created.
•  The Auditioner and the Click are connected to the first two physical output ports.

However it is possible to change any or all of these routes using the tools provided in Mixbus, or a third-party routing
app such as JackPilot (OS X), Patchage (Linux), or qjackctrl (Linux).  Other things that can be routed via JACK
include Track Sends, Track Inserts, and Mixbus sidechain inputs.

Track I/O Selections
Track inputs can be assigned directly from the mixer strip, by clicking on the "input" button.

The menu provides these selections:

•  Edit:  launch the Track Input dialog for this track (see below)
•  Disconnect: remove all JACK connections from this track's input
•  "in 1" ... "in N":  These are shortcuts to the physical soundcard inputs on your system

For convenience, the Master Bus has an "output" button which can be used
to select the ports that the master bus output will feed.  Normally, you con-
nect the Master Bus output to your soundcard outputs.

Track I/O Editor
The track input editor window allows you to connect any
Jack output port to the track/bus input:

•  Add/Remove:  Add/Remove an additional JACK port
to this track. (this is normally disabled in Mixbus, where
tracks are either mono or stereo, but it is kept for com-
patibility with Ardour.
•  Disconnect All:  Removes all Jack connections to this
track's inputs
•  in:  displays the Jack ports that are connected to this
track's input(s).  Click on a port name to disconnect it.
•  Available connections:  There are tabs for your sound
I/O  ("system") and any Jack-aware applications that
are currently running, including Mixbus ("ardour").
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Note: JACK connections use a floating-point 32-bit format, which means that headroom is essentially unlimit-
ed.  You don't have to worry about "clipping" the sound when routing from one application to another. You may

route a single JACK output port to several inputs, and an input port can be routed from several different outputs (the
summing of these signals is done automatically).

%

Note: The "shortcuts" may not display a connection until you select it
from the menu.  These are provided as a quick way to override the

current setting, not a method to see what the track is connected to.

%

Tip:  Each track/bus also provides
a direct JACK output port.  This can

be useful if you want to use Mixbus as a
multitrack record/playback machine.
Every track output can be directly
patched to a physical soundcard input or
output.  To access this feature, click on
the track's  "name" button and then
choose "Direct out".  Mixbuses also have
this feature which is a good way to cre-
ate a cue feed to the headphones of
your artists.

�



Under each tab is a list of Jack ports.  Click on any port name to connect it to the currently selected input.
•  Rescan:  If any new Jack applications were launched since the dialog was created, click Rescan to show the
new state of the software.

Track/Bus Inspector
Found under the Window menu, the Track/Bus Inspector allows you to route the track inputs, outputs, and redirects
from one convenient location.  The tracks/buses are listed on the left, and the right side is similar to the track  I/O
dialog, but it allows connection to redirects as well.

The Jack Menu
The Jack  menu provides some "global" controls over Mixbus's connection to Jack.

•  Disconnect / Reconnect:  Mixbus can be "disconnected" and "reconnected" with the Jack server.  Normally this
is only used for troubleshooting.
•  Latency:  On systems that support it, the latency "buffersize" of the soundcard can be adjusted "on the fly" with
these menu entries.  A smaller latency setting makes Mixbus feel more responsive, and reduces the delay from
soundcard input to soundcard output.  A larger latency setting provides less DSP usage, and a more stable sys-
tem with fewer clicks or glitches, even with a high CPU load.  

55..00  JJAACCKK II//OO
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Note: If you select the "ardour" tab, you will see that you can select any Mixbus port to feed the track, includ-
ing another track/bus output, or the output of the Master bus.  This is a quick way to "bounce" the output from

one or more tracks to a single track, or to set up a routing scheme for complicated effects setups.  Ardour's routing
provides nearly infinite flexibility, but does not guarantee the timing of complicated routing, so please check the tim-
ing of any complicated bus setups.

%

Note: The Mixbus sends, and the Master assign button, are not re-routeable with JACK routing.  The mixbus
and master sends are an inherent part of the Mixbus engine. By default, all tracks are connected to the Master

bus.

%



Mixbus - Editor and Mixer Windows
This document will reference the Editor Window, the Mixer Window, and the Editor Mixer.  The image below indicates
the areas that are being referred to:

A Mixer Strip is a vertically-aligned group of controls which affect a single track or bus.

The Editor Window can show a single mixer strip in the Editor Mixer, while the Mixer Window shows all of the
mixer strips side-by-side, like a traditional mixing desk.

The Mixer Window may be shown using selections under “Window” or the keyboard shortcut (ex: Alt/Opt+M).  The
Editor Mixer may be shown and hidden from within the “View” menu or the keyboard shortcut (Shift+E by default).
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Editor Mixer

Editor Window

Plugin Window
Mixer StripsMixer Window



Mixer Window
When viewed in the Mixer Window, Mixbus resembles a traditional analog console.  Input Channels are on the left,
while the busses and master are located on the right side.

The audio signal flow is generally left-to-right. The signal starts at the input channels (which might be live inputs or
playback tracks), progresses through the mix buses, and into the master.  The channel’s EQ, Filter, Compressor,
panning, bus summing, and master bus processing are performed inside the proprietary Harrison channel plug-in. 

In Mixbus, like other audio workstations, each recording track has its own mixer strip.  These mixer strips resemble
the input channels of a traditional analog mixing console.  Input channels can be configured to be mono or stereo
and by default include all the DSP processing that makes up a real console channel. This is the major difference
between Mixbus and other DAW mixers.  No time is wasted searching for and adding the necessary high-quality mix-
ing tools.

Just to the right of the input channels are the 8 mix bus channels.  Mix bus channels are used to collect the outputs
from the input channels into groups.  For example, in a typical music project, you might send the drums to mix bus 1,
the vocals to mix bus 2, instruments to mix bus 3, and use mix bus 4 as a parallel effects bus, like reverb.  This
allows you to easily adjust the relative levels of these groups and apply processing to them.

The master channel is the final mixer strip on the right.  Typically, the master channel will be connected to your moni-
toring system (speaker outputs).  The output of the Master channel is the final output of your project i.e. your 2 track
master file.  This output is rendered to the final .wav file when you export the session.
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Input Strips
Mix Buses

Master Bus



While it is possible to add additional “utility” buses using the Mixbus editor, most users will find that the built-in
Mixbus signal flow is adequate for all but the most complicated projects. 
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Track Name

Click to rename and other utility functions.

Input Selector

Click to select input for the track from sound card
or app.

Plug-in Controls

Controls from the plug-ins can be mapped here for
quick access.  The number of control slots avail-

able depends upon the resolution of the computer
screen.  A higher resolution will yeld more slots.

EQ Section

3 Band EQ - The lighted button at the top left
enables or disables the EQ. Each band has +/- 15

dB of boost or cut with a sweepable center fre-
quency.

High Pass Filter (HPF) - 12 dB/oct filter with a
Frequency range of 20Hz to 1kHz.

Master Assign (MSTR) and Pan

Click MSTR button to assign this signal directly to
the master channel. Pan control adjusts Left/Right

image (Mix Buses and Master Bus).  Pan is 
“balance” for stereo inputs.

Mute, Solo, and Track Slate

Displays the track name and values as knobs are
adjusted. Use Track Name to change the slate.

Ctrl/Cmd+click on slate to change channel width
between narrow/wide in the mixer window.

Input Trim

The input trim knob can adjust the input level with
+/-20dB of gain.

Fader Automation

Allows the user to select the fader automation
mode – Manual, Play, Write or Touch.

Fader Level Display

Fader level can also be set by entering a value.

Mix Group (Grp) and Meter Controls

The Grp button allows faders to be assigned to Mix
Groups which link fader, solo, and mute controls.

The meter point button selects between input, pre-
fader and post-fader.
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Record Button

Click to arm/disarm the track for recording.

Polarity Invert Button

Click to invert the polarity of the signal.

Pre- and Post-fader redirects

Right-click here to add or remove redirects.
Redirects may be sends, insert paths, or plug-ins.
Redirects positioned above the “---Fader---” are
pre-fader and those positioned below are post-
fader.

Mix bus Sends

Each send may be enabled or disabled with the
lighted button.  The level of each send is
adjustable from -90 to +15 dB.  Note: Mixbus
sends are post-fader and post-pan.

Compressor Section

There are 5 controls for the Harrison channel com-
pressor:  The lighted button enables/disables the
compressor. A triangular slider next to the fader
adjusts the threshold of the compressor.  The
“speed” knob adjusts attack/release time.  A knob
for make-up gain is provided.  The Mode selector
(“L”) may be one of 3 selections:  Level, Compress,
or Limit. These modes accommodate the most
common compression techniques.  The bar to the
right of the threshold slider shows gain reduction in
red.

Peak Meter

A single bar is shown for Mono channels, dual bars
for stereo.

Peak Hold Value

Double-click on the peak hold value to clear it.



There are 8 “mix bus” channels. These are fed from the mix bus sends of the input channels.

99..00  MMiixx  BBuuss  CChhaannnneellss

17Section 9.0 - Mix Bus Channels Mixbus User Guide

Polarity Invert Button

Click to invert the polarity of the signal.

Pre- and Post-fader redirects

Right-click here to add or remove redirects.
Redirects may be sends, insert paths, or plug-ins.
Redirects positioned above the “---Fader---” are
pre-fader and those positioned below are post-
fader.

Tape Saturation

The pointer meter indicates the amount of satura-
tion that is applied to the signal.  Use the “Tape
Sat” knob to adjust the signal for the preferred ana-
log tone. 

Compressor Section

There are 6 controls for the Harrison mix bus com-
pressor:  The upper lighted button enables/disables
the compressor, while the lower engages the
sidechain.  The triangular slider next to the fader
adjusts the threshold of the compressor.  The
“speed” knob adjusts attack/release time.  A knob
for make-up gain is provided.  A Mode selector (“L”)
may be one of 3 options:  Level, Compress, or
Limit. These modes accommodate the most com-
mon compression techniques.  The bar to the right
of the threshold slider shows gain reduction in red.

Peak Meter

Mix bus channels are stereo and show dual meter
bars.

Peak Hold Value

Double-click on the peak hold value to clear it.

Name button

Click to rename or other utility functions.

Sidechain (SC) input button

Click to select an audio signal which will be routed
into the compressor sidechain.  

Plug-in Controls

Controls from the plug-ins can be mapped here for
quick access.  The number of control slots available

depends upon the resolution of the computer
screen.  A higher resolution will yeld more slots.

Tone section

The lighted button in the the top-left corner is used
to enable or disable the tone controls.  Mix bus
channels provides 3 bands of tone control: low

shelving, mid bell, and high shelving.

Master Assign (MSTR) and Pan

Click MSTR button to assign the mix bus signal
directly to the master channel. Pan control adjusts

the Left/Right balance to the master bus.

Mute, Solo, and Mix Bus Slate

Displays the track name and values as knobs are
adjusted. Use Track Name to change the slate.

Ctrl/Cmd+click on slate to change channel width
between narrow/wide in the mixer window.

Fader Automation

Allows the user to select the fader automation
mode – Manual, Play, Write or Touch.

Fader Level Display

Fader level can also be set by entering a value.

Mix Group (Grp) and Meter Controls

The Grp button allows faders to be assigned to Mix
Groups which links fader, solo, and mute controls.
The meter point button selects between input, pre-

fader and post-fader.



Pre- and Post-fader redirects

Right-click here to add or remove redirects.
Redirects may be sends, insert paths, or plug-ins.
Redirects positioned above the “---Fader---” are
pre-fader and those positioned below are post-
fader.

Correlation (Phase) Meter

Indicates mono compatibility of a stereo signal.
When the left and right main buses are in phase
the meter deviates to the right.  Complete deflec-
tion to the left side of the meter indicates 180
degrees out of phase.

Tone section

The lighted button in the the top-left corner is used
to enable or disable the tone controls.  Mixbus pro-
vides 3 bands of tone control: low shelving, mid
bell, and high shelving.

Tape Saturation

The pointer meter indicates the amount of satura-
tion that is applied to the signal.  Use the “Tape
Saturation” knob to adjust the signal for the pre-
ferred analog tone.

Compressor Section

There are 5 controls for the Harrison channel com-
pressor:  The lighted button enables/disables the
compressor.  The triangular slider next to the fader
adjusts the threshold of the compressor.  The
“speed” knob adjusts attack/release time.  A knob is
provided  for make-up gain.  The Mode selector
(“M”) may be one of 3 selections:  Level,
Compress, or Limit. These modes accommodate
the most common compression techniques.  The
bar to the right of the threshold slider shows gain
reduction in red.

Master Peak Meters

Unlike the track and mixbus meters, which can
exceed 0dBFS safely, the master output meter will
turn yellow when the peak signal approaches -2
dBFS.  The built-in limiter is activated at -1 dBFS.

Peak Hold Value

Double-click on the peak hold value to clear it.

Mixbus provides a single Master channel.  The Master channel provides the final output signal for listening via
speakers or exporting to wav files.  In addition to the features listed below, the Master channel has a built-in trans-
parent signal limiter to avoid the distortion that occurs in overly loud digital signals.
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Name button

Click to rename or other utility functions.  
Note: There is no “input” button for the Master

channel. The input for this strip comes directly from
the mix buses and/or the input channels.

Plug-in Controls

Controls from the plug-ins can be mapped here for
quick access.  The number of control slots avail-

able depends upon the resolution of the computer
screen.  A higher resolution will yeld more slots.

K-meter

This meter, designed with input by Bob Katz, indi-
cates the average level of the stereo audio signal.

The meter is calibrated to -14dBFS.  See
http://www.digido.com/level-practices-part-2-

includes-the-k-system.html for more information.

Master Bus Limiter

The limiter for the main bus can be engaged by
clicking the left button.  The right button engages

the look-ahead function of the limiter.  Gain reduc-
tion is shown in yellow by the meter above the

slate.

Mute and Master Bus Slate

Displays the bus name and values as knobs are
adjusted. Use Name button to change.

Input Trim

The input trim knob can adjust the input level with 
-20dB to +10dB of gain.

Fader Automation

Allows the user to select the fader automation
mode – Manual, Play, Write or Touch.

Fader Level Display 

Fader level can also be set by entering a value.

Mix Group (Grp) and Meter Controls

The Grp button allows faders to be assigned to Mix
Groups which links fader, solo, and mute controls.
The meter point button selects between input, pre-

fader and post-fader.



Mixbus Knobs and Faders:
•  When a knob is in the “default” position, the indicator is very dim.  This allows you to scan the mixer for set-
tings that are not at default.
•  Mixer strip knobs can be double-clicked to instantly return them to their default value.
•  Holding Ctrl/Cmd while turning the knob provides a fine-adjust mode, while Shift+Ctrl/Cmd allows super fine
adjustments.
•  Mixbus knobs and sliders incorporate an “in-on-change” feature.  When any knob or fader is clicked and
changed, it will automatically enable the control by also setting the “in” or “on” control for that section.

Default Signal Routing:

When you make new tracks, they are automatically assigned to the master channel to allow the signal to be moni-
tored quickly.

Floating-Point processing:

Mixbus uses a floating-point internal architecture, it is possible to exceed 0 dBFS on the channel and mix bus strip
meters without ill effects.  For this reason there is no colored indication of overly-loud signals on input and mix bus
strips.

Unlike the channel and mix bus strip meters, which can exceed 0dBFS safely, the master output meter will turn yel-
low when the peak signal approaches -2 dBFS.  This is an indication that the signal may be affected by the built-in
limiter.

Master Bus Volume:

Normally you will use the volume knob provided by your computer or I/O device to control the loudness of your
speakers.  If you are using the fader of the Master strip to control speaker volume, remember to set the fader to the
correct level before you export your project to a .wav file, since the master fader level is applied to the export.  Use
the K-14 meter to verify that the export volume is at a reasonable level.

Right-click:

Mixbus uses the right mouse button for many, many features.  Try right-clicking on tracks, regions, mute buttons,
solo buttons, group panes, regions, selected ranges, markers, mixer redirects, clocks, the region list, and the marker
bar area.  Each will launch a context menu that provides useful features. 

"If you asked a hundred engineers, mixers and producers to define the "perfect console" you would proba-
bly get a hundred answers.  The answers, however, would all contain the same salient points.

The "perfect console" would have totally transparent sound, capturing the true musical quality of all per-
formances.  It would have unlimited features, facilities, and functions.  It would perform all required tasks
with a minimum of operator effort.  It would be totally reliable and require no preventive or corrective mainte-
nance... 
You can spend the rest of your life looking for the "perfect console".  You'll never find it.  You will find, how-
ever, that we have what you need." - Harrison MR20 brochure, circa 1982
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Redirects
The black box at the top of each channel strip is the "redirect box".
Mixbus uses the term "redirect" for the items that can be inserted into
a channel strip: plug-ins, sends, and inserts.  In the picture to the
right, the track has a reverb plug-in, an insert, and a send.  The
reverb and the insert are pre-fader (because they are above the fader
entry)  while the send is post-fader.  The signal flow of Mixbus is very
flexible:  you can order sends, inserts, plug-ins and the fader arbitrari-
ly.

Plug-in Control Sliders

Below the redirect list, there is an area for "Plug-in Control Sliders".
Each Slider controls a single parameter from a single plug-in.

When a plug-in is instantiated on a track/bus, all unassigned sliders
will be filled with the parameters of the plug-in, starting with the first
parameter of the plug-in and continuing to the last.  Right-clicking on a
plug-in control will provide a menu that allows the slider to be unassigned, or you can choose any plug-in parameter
to map to the slider.  This allows you to "build" a control panel for the most-used parameters of the plug-in and make
them available directly from the mixer strip.

The Redirect Menu

Right-clicking in a redirect box will launch the redirect menu.  These choices are available in the menu:

•  New Plug-in/Favorites:  a list of favorite plug-ins, pre-selected from the Plug-in Manager  (see below) 
•  New Plug-in/Manager:  launch the Plug-in Manager  (see below) 
•  New Plug-in/By Creator:  a list of plug-ins, sorted by their creator 
•  New Plug-in/By Category:  a list of plug-ins, sorted by type (note: this is only useful for plug-in formats that
support this)
•  New Insert:  create a new Insert (Send and Return)
•  New Send:  create a new Send
•  Activate/Deactivate:  activate/deactivate the selected redirect (you can also middle-click  (ctrl-alt-click on OSX)
any redirect to activate/deactivate it)
•  Delete:  delete the selected redirect (you can also shift-left-click any redirect to delete it)
•  Cut/Copy/Paste:  Cut/Copy/Paste the selected redirect
•  Rename:  Rename the redirect (yes ... even plug-ins)
•  Clear:  Remove all redirects from this track/bus
•  Activate/ Deactivate All:  Activate/deactivate all redirects on this track/bus
•  Edit:  Pop open the editor for the selected redirect  (you can also double-click on any redirect to edit it)
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Note: The "---Fader---" entry actually encompasses the chan-
nel's fader, compressor, filter, and EQ.  See the signal flow dia-

gram for more details.

%

Note: By default, plug-ins and inserts will be created pre-fader,
while sends will be post-fader.  But you can drag them into any

order you choose.

%

Note: The number of plug-in sliders will differ depending on your screen's vertical resolution.  The number of
sliders cannot be selected by the user.

%



Plug-ins
Mixbus can load plug-ins in several formats.  Mixbus can only use plug-ins that meet these criteria:

•  The plug-in must be a supported format on your platform (see below)
•  The plug-in must be installed in the standard folder for your platform.
•  The plug-in must be compiled for your platform. (Intel/PPC, OSX/Linux, 32-bit/64-bit)
•  The plug-in must support either 1>1 I/O   (for mono channels) or 2>2 I/O  (for stereo channels)

A summary of plug-in support in Mixbus:

Plugin input/output configurations for all formats

Mixbus loads mono plugins into mono tracks, and stereo plugins into stereo tracks/buses.  Plugins with an unequal
number of inputs and outputs (such as a mono plugin with a sidechain input, or a mono-in, stereo-out effect) some-
times cannot be loaded into Mixbus tracks or buses.  However, starting with 2.5, this is largely alleviated.  Mixbus will
load a plugin into mono or stereo tracks, as long as the plugin has “at least” as many inputs and outputs as the track
needs.  Additional I/O on the plugin (such as sidechains)  will be ignored.  We will allow sidechains and other multi-
channel features in a future version of Mixbus.

Apple AU plug-ins  (supported on OSX only)

AU (Audio Unit) is the native (Apple-developed) plug-in format for OS X.  Most AU plugins can support either mono
or stereo operation from the same plugin package.

LADSPA plug-ins (supported on all platforms)

LADSPA is the "Linux Audio Developer’s Simple Plug-in Architecture".  LADSPA plugins are simple to develop and
are freely available.  There are nevertheless some LADSPA plug-ins that are quite good.  LADSPA plug-ins do not
support customized GUIs,  they will be shown as sliders on a simple window.  Being very portable, most LADSPAs
are available for all platforms (OSX, Linux and Windows).  Unlike other formats, Mixbus can load a mono LADSPA
plugin into a stereo channel (by duplicating the plugin and assigning the same controls to both sides of the signal).

LV2 plug-ins

The "next generation" open-source plugin format.  LV2 plugins have several advantages over other formats.  For
example, plugins do not have to be instantiated to be scanned so startup is much faster.  For developers, LV2 is
compleletely unencumbered by licensing restrictions.  Harrison’s bundled plugins currently use the LV2 format, and
the same plugins operate on WIndows, Mac, and Linux. This allows you to share sessions with users on other plat-
forms, and have your sound remain unchanged.

Steinberg VST plug-ins (currently supported on Windows only)

VST (Virtual Studio Technology) plug-ins were developed by SteinbergTM and are the most common plug-in format on
Windows.  VST plug-ins can be developed for Windows, OSX, and Linux.  Currently, Mixbus supports VST plugins
on Windows only, but support on other platforms is under development.

Digidesign AAX/TDM/RTAS plug-ins (no support currently)

AAX, RTAS and TDM plug-ins are proprietary formats for ProToolsTM.  Mixbus does NOT support RTAS or TDM plug-
ins.  It is unlikely that Mixbus will ever support AAX, RTAS or TDM plug-ins.

Windows DirectX plug-ins (no support currently)

The DirectX plug-in API was developed by Microsoft and is the native plug-in format for Windows.
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Note: Instrument plug-ins  (plug-ins that take MIDI input and convert them it into audio) are currently not sup-
ported.

%

Note: While we have taken care to follow the specifications for each plug-in format,  plug-ins are developed
by third-party vendors.  This means that Harrison cannot take responsibility for plug-ins that don't work as

expected.  Please use caution when trying a plug-in for the first time.  Verify that all the functions work as expected
before committing to using a particular plug-in in a session.

%



Latency Compensation
Some plug-ins,  particularly complicated FFT-based plug-ins that use techniques such as convolution, can require
significant latency (time delay) from the input to the output.  This can cause problems if the delayed signal is mixed
with a signal that is not delayed.  A long delay can cause the tracks to sound "out of time", while a very short delay
can cause comb filtering.  Mixbus can automatically accommodate plug-in and insert latencies for you.  To do this,
Mixbus delays the non-affected tracks to match the track with the longest latency.  Please be aware of these facts:

•  Tracks can accommodate "unlimited" latency by buffering the audio from disk earlier than it is needed.
•  Mix Buses are limited to 8192 samples of latency compensation.  If the total latency of all plug-ins in a Mix Bus
exceeds 8192 samples, then a time offset will occur.
•  "Buses" created with the Add Track/Bus dialog (we call these "utility buses") do not support latency compensa-
tion.

Inserts are also latency-compensated if they are inserted on a track or Mix Bus.  Please see "Insert->Measure
Latency", below.

Plug-in Manager
The Plug-in Manager Window provides a rich set of controls for managing your installed plug-ins, and making them
quickly available when needed.

•  Fav:  If this column is checked, the plug-in will appear in the "favorites" shortcut in the redirect menu.
•  Hid:  If this column is checked, the plug-in will NOT appear in the "by creator" or "by category" shortcut menus
•  Search:  the search bar allows you to instantly find plug-ins by Name, Type, Category, Author, Library,
Favorites or Hidden properties
•  Add:  This will add the selected plug-in to the list at the bottom.  Continue adding plug-ins to the list if you'd like
to add more than one plug-in at a time.
•  Remove:  This will remove the selected plug-in from the list at the bot-
tom.
•  Refresh:  This will reload the list of plug-ins, if you've added or
removed plug-ins from your system since the dialog was first shown.
•  Insert Plug-in(s):  This will insert the list of plug-ins in the bottom pane
to the mixer strip that launched the Plug-in Manager Window
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Tip: You should always use the
Search bar when looking for a plug-

in.  Just type the first few letters of the
name of your plug-in, and your plug-in
will be sorted to the top window instantly.

�



Sends
When a new send is create, a window for configuring the Send will immediately appear.  By default, Sends have no
outputs and must be configured as needed.  Click "add" to add ports, and connect them to the destination that
should receive the output of the send (shown in the second picture, below)

•  Add/Remove:  adds/removes a Jack port to the send.
•  Disconnect All:  disconnects all Jack ports  (does not remove ports)
•  Available connections:  This is a list of all the available Jack connection ports, with one tab for each Jack appli-
cation, and one for the system sound I/O ("system").

After a send has been configured, a double-click on the send will launch the Send Editor:

In addition to the output management,  The Send
Editor also has a volume slider and a panner (if
the number of outputs is > 1).

1122..00  RReeddiirreeccttss::    PPlluugg--iinnss,,  SSeennddss  &&  IInnsseerrttss

23Section 12.0 - Redirects:  Plug-ins, Sends & Inserts Mixbus User Guide

Note: The number of "ports" created will define the channels of the send.  Sends can have 1 (mono), 2
(stereo) or more (multichannel) ports assigned. 

%

Note: Sends are created "deactivated", you
must Activate the send before it will work.

%



Inserts
An Insert incorporates a Jack "send" output and a Jack "return" input.  The Insert send/return allows the audio signal
to be routed out of a channel and back into it, after performing some external processing.  Inserts are often used to
"patch in" a piece of outboard gear that is not available as a plug-in.

•  Measure Latency:  Once your insert is connected to a Jack-aware program, or an external piece of gear, then
click this button to measure the latency.  If the Insert is used on a track or Mix Bus, this delay will be accommo-
dated automatically.

Outputs

•  Add/Remove:  adds/removes a Jack port to the insert "send".
•  Disconnect All:  disconnects all Jack sending ports  (does not remove ports)
•  Available connections:  This is a list of all the available Jack connection ports, with one tab for each Jack appli-
cation, and one for the system sound I/O ("system").

Inputs

•  Add/Remove:  adds/removes a Jack port to the insert "return".
•  Disconnect All:  disconnects all Jack return ports  (does not remove ports)
•  Available connections:  This is a list of all the available Jack connection ports, with one tab for each Jack appli-
cation, and one for the system sound I/O ("system").
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Note: Inserts are created "deactivated", you must Activate the insert before it will work.%



Basic Editing Concepts
Users familiar with other DAW conventions will quickly adapt to the recording and editing features of Mixbus.  

Creating Tracks
Immediately upon opening the editor, you will probably want to create one or more tracks for recording.  Use the Add

Track/Bus to create any number of mono or stereo tracks for your session.  Alternatively, you can Import existing
audio from the File menu.  Finally, if you find yourself starting the same way with each session, you can create a
session template which will be available as a starting point next time you start a new session.  Snapshots conve-
niently save your entire editing/mixing session for later recall.  Saving a snapshot is instantaneous and takes up
essentially no extra disk space (snapshots all share the same audio data on disk).

Mixbus uses the right mouse button for many features.  Try right-clicking on tracks, regions, mute buttons, solo but-
tons, group panes, regions, selected ranges, markers, mixer redirects, clocks, the region list, and the marker bar
area.  Each will launch a context menu that provides many features. 

Track Management
On the far left of the edit window, the Editor Mixer is a single mixer channel strip that “follows” the selected track.
The editor mixer can be hidden or shown as needed.  To see all of the mixer strips for the tracks and buses on one
window, show the Mixer window.  Alt/Opt-M toggles between the Mixer and the Editor windows.  Mixer strips have an
Input button for selection of the physical  input that feeds the track.  For example if you have 8 tracks but only a 2-
input soundcard, you must route the inputs to the tracks as-needed.  Another way to manage track inputs and out-
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Editor Mixer

Track Audio Region

Timeline & 
Markers Ruler

Transport 
Toolbar

Edit Mode &
Grid Options

Editor Sidebar

Note: Unless otherwise noted, "click" means a left-click.  Right and middle-click are called out when specified.%



puts from a single interface is the Track/Bus Inspector.  From this window you can arbitrarily route tracks and
busses between Mixbus I/O's, soundcard I/O's, and other application I/O's. 

The right side of the screen is a pull-out drawer which accommodates several different functions.  Most panels have
a right-click context menu for additional features:

•  Tracks/Buses – drag&drop to reorder tracks, or click to show/hide them
•  Regions -  shows all of the recorded or imported regions.  Drag&drop from here into the editor.
•  Snapshots – Click a snapshot to recall all of the settings in the snapshot
•  Edit Groups – Click the +/- buttons to create edit groups, and enable them

Mixbus supports persistent undo.  When you close your editing session the “undo” information is saved with the
session.  Upon reopening the session, you can still “undo” the edits that happened prior to your closing it.  The main
session file, and each of the snapshot files in the session folder, have their own persistent undo storage file.

Track and Bus Management in the Editor
On the right side of the edit screen there is an adjustable 'shelf' with tabs.  The
Tracks/Buses tab is used to manage tracks.  You can click on the checkboxes to
hide/show tracks, and you can drag/drop the tracks to change their order.

A right-click menu provides these options:
•  Hide/Show all
•  Hide/Show all tracks
•  Hide/show all buses
•  Show tracks with regions under playhead (only shows the tracks that have active
audio regions right now)

Below the track/bus area, there is a list of the 8 Mixbuses, which can be shown or hidden.

Track and Bus Management in the Mixer
On the left side of the mix screen, there is an adjustable 'shelf' with tabs.
The Tracks/Buses tab is used to manage tracks.  You can click on the
checkbox to hide/show tracks, and you can drag/drop the tracks to change
their order.

A right-click menu provides these options:
•  Hide/Show all
•  Hide/Show all tracks
•  Hide/show all buses
•  Show tracks with regions under playhead (only shows the tracks that
have active audio regions right now)

Below the track/bus area, there is a list of the 8 Mixbuses, which can be
shown or hidden.
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Note: Normally “snapshots” are used as backup states.  You store the snapshot and continue working on the
main session.  Future “save” operations will apply to the selected session, not the snapshots.  If you prefer

that future “save” operations go into the newly-created snapshot, then you'll want to do a “Save As”.

%

Tip: You can also select tracks in
the editor and use the "Move tracks

Up/Down" command from the track
menu.

�

Tip:  Ctrl-Alt-Click (Cmd-Opt-Click)
on a track's Mute, Solo, or Rec-
enable to toggle ALL the tracks in a

session.

�

Tip:  You can Ctrl/Cmd-click on the
track's name slate, and make the

track wide or narrow.  Shift-Ctrl/Cmd-
click to make ALL the tracks or ALL the
buses narrow/wide.

�



Using Tracks
To the left of the editing canvas are the track headers.  You can select or deselect a
track by clicking on the empty area.  You may shift-click to select a range of tracks, or
Ctrl/Cmd-click to select and deselect individual tracks.  Right-clicking the empty track
area will open the track context menu.  Certain functions such as mute, solo, and
record-arm can be applied to ALL tracks simultaneously by Ctrl-Alt-Shift-clicking (Cmd-Opt-

Shift-click).  You can manipulate multiple tracks at once by selecting them and then
using operations from the “Track” menu in the main application.  The 3 horizontal lines
in the bottom corner of the track allows it to be resized vertically.

The “P” key on each track allows selection of the track's playlist.  Playlists

can be used to enable multiple takes in a single track, or the sharing of
playlist data across multiple tracks.  Some users create a new playlist for
each recording “take” while others use Layers to manage takes.

Tracks also support automation of the fader, panner, and other processing
parameters including those of plug-ins.  The “A” button in each track opens
the automation menu which allows editing of automation data.  Each param-
eter has multiple dynamic automation states: Manual, Play, Write, and Touch.  These control whether dynamic
automation will play back or be recorded while playing.  Automation lines can be created and edited with the Object
mouse mode. You may also select a Range of automation for deletion, or to raise/lower the selected range.

Groups
Tracks may be assigned to “edit groups” using the G button.  When tracks are assigned to an edit group, and the
regions align exactly on the start and end times, then all changes to one track will be applied to all other tracks in the
edit group, regardless of whether the grouped tracks and regions are selected for editing.  This is very convenient for
editing multitracked instruments.  Another convenience is that some playlist operations (such as “New”) will apply
across the edit group.  Edit groups are created and enabled in the pullout drawer to the right of the screen.

Recording, Loops and Punch Ranges
Above the recording tracks is the “ruler bar” area.  Left-click anywhere in the ruler bars to locate the playhead.  You
can also locate the playhead to the current mouse location with the “p” key. Right-clicking in each of the “ruler bar”
areas will allow you to create location markers (cue points), CD markers, tempo markers, or meter markers.  Clicking
and dragging in the “range” or “loop punch” ruler bars will allow you to define song ranges, loop ranges, or punch

in/out ranges.  Right-clicking on the ruler bar names will allow you to show or hide the various rulers.
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Tip: Ctrl-Alt-Shift-click (Cmd-Opt-
Shift-click) on a track header will

apply the click to ALL tracks.  If you click
on the track background, it will (de-
)select all tracks.  If you click on the
Record, Mute or Solo button, it will apply
that operation to ALL tracks.

�

Note: In addition to edit groups, you can create mix groups from the mixer window.  Mix groups allow the
same sort of features as edit groups, but they apply to mixing functions such as fader, mute, solo and record-

arm.  This is another convenient feature for multitracked instruments.

%

Tip: Holding “Alt” will temporarily override a mix group assignment for the fader and mute.  For example, if you have 2
tracks in a mix group, the faders will move together if you move one.  But if you’d like to move a single fader without dis-

abling the mix group, you can hold “Alt” while you move the fader, and it won’t cause the other grouped fader(s) to move.

�



Navigating in the Editor window: Zooming and Panning
The area of the editor where the regions is shown is called the "canvas".  There are several ways to navigate (pan
and zoom) the editor canvas.

In the bottom left corner there is a menu to select the zoom focus.  There are
also 2 buttons, one to increase and one to decrease the zoom level.  The
"zoom focus" affects the operation of the zoom buttons and the zoom key
commands by changing the focal point for the zoom.

Zoom focus can be one of:
•  Left:  Zoom focus is the left side of the screen.
•  Right:  Zoom focus is the right side of the screen.
•  Center:  Zoom focus is the center of the screen.
•  Playhead:  Zoom operations will center on the playhead.
•  Mouse:  Zoom operations will center on the mouse position (only
makes sense when using the zoom keyboard commands; when buttons
are clicked the Playhead is used as zoom focus).
•  Edit Point:  When the Playhead is the Edit Point, it is used for zoom
focus.

In addition to the scroll bars, there are several scroll-wheel commands that
can be used to navigate the editor canvas:

•  Scroll:  Scrolls vertically.
•  Shift+scroll:  Pan the editor canvas left/right.
•  Ctrl/Cmd+scroll:  Increase/decrease the zoom (note:  this always uses
the Mouse as zoom focus).
•  Alt/Option+scroll:  Increase/decrease the height of the track that is
currently under the mouse.

The Transport Menu and Toolbar
Many items in the Transport Menu and Toolbar are self-explanatory.  For
more details click Help->Reference.
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Tip:  (Linux Only) Clicking in the
timeline area, you can drag up or

down to increase/decrease the zoom
level (note:  this always uses a "zoom
focus" of playhead).

�

Tip: The View menu also has some
useful commands for navigating the

edit screen.  These operations are very
important to learn if you want to navigate
the edit screen quickly.

•  Zoom to Region:  This zooms the
timeline to fit the length of the
selected region(s).
•  Zoom to Region (W&H):  This fills
the entire edit window with a single
region.
•  Toggle Zoom state:  Toggles to
the previous zoom command. 

�



Region Gain and Automation
Mixbus has 2 separate types of automation:  Region Gain and Automation.  Region Gain envelopes are often used
for repair work, such as reducing unwanted breaths, accentuating syllables, or reducing noise.  Automation is often
used for creative changes such as fading elements in and out during a song.  Region Gain only adjusts the volume
(level) of the region across time.  Automation can be applied to many different mixing parameters including the input
trim, fader, panning, or plug-in parameters.

Region Gain

Region Gain is a volume envelope that extends
for the length of the region.  By default, the
region envelope is "unity" (i.e. no change) across
the entire region and it is hidden.  To adjust
region gain with the mouse, you must use the
Gain tool.  The first click on a region with the Gain tool will cause the gain
line to appear.  By default , a region has 2 control points, one each at the
start and end of the region.

Mouse operations using the Gain tool inside a Region:

•  Click anywhere in the region to create a new control point, and con-
nect it to the points on either side.
•  Click a control point to grab it and move it.
•  Click a line to move the gain points on either side of the line.
•  Click in the region and drag to create a "range".  Now click inside the
range and you can drag the entire range up/down.
•  Cmd/Ctrl click on an existing line to add a new control point.

Operations available in the Region menu and right-click context menu
include: Show/Hide Gain Line, Enable/Disable Gain Line, and Reset Gain
Line.  

Automation

Many mixer parameters may be automated:  fader, mixbus sends, eqs, compressor, and even plug-in parameters.

Realtime Automation:  Touch Automation

In Realtime automation the parameter is put into a "record" mode.  The moves are recorded while the user moves
the knob.  There is an automation button next to the fader because this is a very commonly-automated control.  You
can automate nearly every mixer parameter by showing the automation track for that parameter and setting the
mode.  Here is a description of the modes:

The mouse wheel has a slightly different automation mechanism.  When the wheel is turned, it "touches" the param-
eter and begins recording the move.  The automation continues to record until the transport stops.  This is some-
times called "Latch" mode.
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Tip: If you want to quickly change
the gain over the entire region, then

click on the region to show the line, and
then grab the line and move it up/down.
This is an alternative to Region Level.

�

Tip:  This is an excellent way to
tweak a syllable or reduce a section

of noise, and it is often more transparent
than deleting it entirely.

�

Tip:  You can right-click on the
range and choose "reset gain line"

to return the gain line to unity through
the length of the range.

�

Manual Automation is ignored.

Play
Whenever you locate, the parameter will jump to the value that is recorded in the automation.  You can-
not change the value manually

Write

When locating, the value will stay as it is (no playback of automation).  During playback (only), the cur-
rent value will be written to automation.  You can move the control manually and your move will be writ-
ten to the automation.

Touch
The parameter will act like it is in Play, unless you "touch" it with the mouse.  Then it will record your
moves until you release the mouse button.



Automation Thinning: When automation is recorded in realtime, the
automation is "thinned" so that only enough control-points are created to
adequately capture the moves.  The points will appear very sparse if the
control is unmoving or slow, and will get created very close together during
fast moves.  The aggressiveness of thinning can be adjusted via a configu-
ration file if necessary.

Punching In: When you punch-in a change 2 points are created: one to
hold the previous value, and one to start the new changes.  Similarly, when
you release the control (or stop a pass in Write mode) then 2 points are cre-
ated:  one which ends the new changes, and one to hold the previously-existing value.  Currently there is no "ramp"
time when you release a parameter.  This will be added in the future.  You can add a ramp (when needed) using the
graphical editor.

Graphical Automation Editing:  Automation tracks

You hide and show automation lanes using the “A” button on the track header.

Automation appears in a separate track from the audio.  Multiple automation tracks
may be shown simultaneously.  If the automation track is associated with an audio
track, a "ghost" of the region's audio will appear in the track.  Buses do not show
waveforms in the automation tracks.

•  Click anywhere in the region to create a new control point, and con-
nect it to the points on either side.
•  Click a control point to grab it and move it.
•  Click a line to move the gain points on either side of the line.
•  Click in the region and drag to create a "range".  Now click inside the
range and you can drag the entire range up/down.

For a more detailed explanation of the automation in Mixbus, watch this video from our YouTube Channel:
http://www.youtube.com/watch?v=UJbjPbpoWlk
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Tip:  Automation may be edited
using either the Object tool or the

Gain tool.

�

Note:  Remember that in order for the automation to be auditioned, the parameter must be in "Play" mode.
You do NOT have to be in write or Touch mode to graphically edit the automation though.

%

Note:  The "Play" value outside of the automation is the first (when before) or last (when after) value.%

Tip: "Write" automation is a quick
way to copy settings from one

place to another.  Locate the playhead
while the parameter is in "play" to pick
up the value you want to apply some-
where else.  Now change the mode to
Write, and locate to the new place.
Then play through the desired section to
apply the setting.

�

Note:  Automation is only recorded during forward playback.  However it is possible to record automation
while the transport is looping!  Using this feature you can audition several different passes of the automation.

When playback is stopped, the most recently-recorded moves will be kept.  For example, if you loop 3 times and
then stop halfway through the looped section, the resulting automation will be the first half of the 4th pass and the
last half of the 3rd pass.

%



Edit Modes
There are 4 different editing modes when moving regions: Slide, Lock and Ripple.  The edit mode selector is to the
far left, directly underneath the transport controls.  Slide allows arbitrary movement.  Lock allows trimming, fades and
track shuffling, but does not allow the region to be moved in time.  In Ripple mode, changes to a region are “rippled”
to other regions on that track in the future.  Moving, trimming, and deleting regions will slip the regions later in time
accordingly.  In addition, there are multiple Grid (snap) options which are described below.   

Editing Tools
The Edit Tools bar allows selection between several different editing tools.  Each tool also has an associated shortcut
key, and can be changed via the "Edit->Editing Modes->Mouse Mode" menu.

Object Tool

The Object tool allows editing of object properties on audio regions such as position, length, and fade in/out.
The object tool also allows manipulation of automation control points in fader or plug-in automation.  Just a
few of the operations of the Object tool include:

•  Click on a region to select it for editing, or drag a region to move it.
•  Click inside the colored bar of a region to trim the start or end points.
•  Click on a regions fade-in or fade-out handle to adjust the fade length.
•  Click inside an automation track to edit the automation data.
•  Drag on a region to define a range of automation.

See “Object (Region) Editing" (below) for more details on the Object tool.  If the "Smart" button is selected, then the
Object tool also gains many features of the Range tool;  see "Smart Editing" for more details.

Range Tool

The Range tool allows the user to select and drag across a range of time.  The time-range can span across
multiple tracks and regions, as if the range were a contiguous piece of audio tape.  Tracks that are selected in
the current range are highlighted blue in the edit window.  You can add or remove tracks to the selection by
clicking with the mouse.

•  Drag across a range of time to create a contiguous
selection.
•  Click the boxes in each corner of the selection to
lengthen or shorten each end of the selection
•  Right-click on the selection to launch a menu that
allows looping, bouncing, exporting, consolidating, or
analyzing the selection.
•  Use the functions in the Edit menu to cut/copy/paste or
otherwise manipulate the selection.

Zoom Tool

The Zoom tool allows the user to zoom in and out on the timeline.

•  Drag across a range of time to zoom-in to fill the edit screen with the time range.
•  Click to zoom in on the selected point on the timeline.
•  Middle-click to zoom out on the selected timeline.
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Note: Zooming can also be controlled with the View menu or the mouse-wheel, see the section on Key short-
cuts.

%



Gain Tool

The Gain tool allows the user to edit the gain curve associated with audio regions.

•  Click on a region to edit the region's gain line.  For more details, see "Region Gain and Automation".
•  Drag on a region to select a range of the region's gain line.
•  Click on an automation track to edit the automation data
•  Drag on a region to define a range of automation

TimeFX Tool

The TimeFX ("stretch") tool allows the user to stretch regions to be longer or shorter, without changing the
region's pitch.

To use the TimeFX tool, drag on a region to lengthen or shorten the region.  This will launch a dialog:

•  Strict Linear:  Click this to force Mixbus to use a simple
resampling method that works equally poorly on all material.
(not used normally)
•  Contents:  Choose an advanced resampling mode that
best matches the sound of the region.

•  Stretch/Shrink:   Initiates the stretch operation.

Audition Tool

•  Click on a region to hear the region through the auditioner path (this means without processing)
•  Drag on a region to "scrub" the audio in the direction of mouse movement.

"Smart" Editing
When Smart Mode is engaged, the "Object" Mouse mode takes on some of the features of the Range
mode.  The top-half of a track operates in range mode (allowing the user to drag-select a time range on
one or multiple tracks).  The bottom-half of the track operates like Object mode, allowing the user to grab a
single region, or rubberband-select a group of regions.  Other features of Object mode (such as trimming regions or
adjusting fade lengths) are still possible in this mode.  The cursor will change to show either Range or Object tools
when the user transitions from the top of the track to the bottom of the track.  “Smart” mode is only lighted when the
Object (hand) tool is engaged, but the Smart setting is remembered at all times.

The Edit Menu
Most items in the Edit Menu are self-explanatory.  For details about specific features, click Help->Reference.
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Join Playhead Mode
Join Playhead is the horizontal button under the "play range' and "play" buttons.
Join-Playhead automatically moves the playhead to allow quick auditioning of selected
ranges and/or the most recently-edited Region.

Behaviors with Join Playhead on:

•  Starting playback (with the spacebar or any other means) will play the
Range selection, if there is one.
•  A single click in Range (or Smart-Range) mode will locate the play-
head to that location.
•  When a Range selection is made, the playhead will be located to the
beginning of the range.
•  When a region is selected with Object mode, the playhead will be
located before the region, with the user-defined pre-roll.
•  When a fade-in or fade-out is adjusted, the playhead will be located
before the fade, with the user-defined preroll.
•  When a region is start- or end-trimmed, the playhead will be located
before the start or end, with the user-defined preroll

Behaviors with Join Playhead off:

•  Editing clicks (such as object grabs or range selections) will have no
effect on the playhead location

Operation Priority
When an editing operation occurs, Mixbus must determine where the operation applies.  This depends on many fac-
tors including the type of operation, the location of the Edit point, the existence of a selected Range, Track
Selections, or the Implied Range.  Most of the time Mixbus will do exactly what you expect it to.  If it doesn't do what
you expect, then it might be due to an unexpected operation priority.  See the table below.

The Edit Point

Functions on regions such as splitting, trimming, and pasting will happen at the currently defined edit point.  The
edit point can be the mouse cursor or the playhead.  Mixbus allows you to choose between the two modes on the fly
using the edit point button (in the picture below, Playhead is selected as the edit point). 
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Tip:  The pre-roll length for Join-
Playhead operations is changed in

"Preferences->Misc->Edit Audition
Preroll".  You can also start playback
with pre-roll at any time by using the
"Transport->Play with Preroll" command.  

�

Tip:  The combination of Join
Playhead, Auto-Return, Auto-Play

options give a wide variety of possible
operations.  If you are familiar with
another workstation’s conventions, you
should experiment with these settings to
see if one of them matches your expec-
tations.

�

Object (Region) Editing Functions: Edit Point Functions: Range Editing Functions:

Example: Mute, Normalize,
Reverse, Transpose, Nudge, Cut*

Examples: Split, Trim, Align, Nudge Examples: Separate, Crop, Cut*

Priority: (1) Any Selected Regions,
(2) Any regions on selected tracks
under the edit point (3) A region
directly under the mouse (even if the
edit point is “Playhead”)

Priority: (1) Any Selected Regions
at the Edit point, (2) Any regions on
selected tracks under the edit point,
(3) All regions under the edit point if
no tracks or regions are selected. (4)
The region directly under the mouse.

Priority: The selected Range

Note: Some operations, such as Nudge and Cut (Delete), are special cases that can apply in multiple ways.%



Object (Region) Editing
The basic element of audio editing in Mixbus is the Region.  Another common name for a Region is a "clip".  A region
represents an audio file (or a portion of an audio file) on disk.  Regions can be moved, stacked, trimmed, copied,
deleted, and otherwise edited.  The maximum length of a region is the length of the file that it uses as a source, but it
can be much shorter.  A region might represent just a small snippet (such as one syllable or drum hit) from the
source file.  Editing or deleting a Region does not change the source file in any way.  This is called non-destructive

editing.  Regions can only exist on tracks.  You cannot drop a region onto an audio bus.

Regions have several "hot spots" that can be modified using the left mouse button when in Object or Smart-Object
mode.  Object edits follow the Grid selection, so operations will snap to the nearest Grid location if it is turned on.

Additional mouse commands on regions include:
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Tip:  When you move/drag a
range, it becomes visibly transpar-

ent.  This allows you to see the regions
underneath.  This sometimes helps if
you are recording an overdub or replac-
ing one drum sound with another.

Tip:  Combining the Trim, Fade
In/Out, and Fade Length, you have

complete control when assembling a
crossfade between two regions.  With
these operations you can find the per-
fect location and length of a crossfade
with a minimum of effort.

Tip:  You can select multiple
regions at the same time using

Ctrl/Cmd-click or selecting them with a
rubberband box.  Regions selected this
way will edit together:  you can move,
trim, or fade them all at the same time.

� ��

Move Click in the waveform area to drag the region in time or across tracks.

Start/End Trim

Click on the colored bar at the bottom to trim the start/end of the
region.  If you are nearer the start of the region, you will trim the start
time.  If you are nearer the end of a region, you will trim the end time.

Fade In/Out Grab the Fade Handle on either end to change the region's fade.

Fade Length
Grab the yellow crossfade area to lengthen or shorten the region's
fade time, while leaving the endpoint of the fade fixed.

Note:  For many region operations, you don't have to actually select
the region.  Just hover the mouse over the region, and use the short-

cut key.  The shortcut keys are listed in the Region menu.  This is a fast
way to mute/unmute regions in a session, for example.

% Tip: When one or more regions
are selected, you can use the oper-

ations in the main Region menu to oper-
ate on all the selected regions simultane-
ously.

�

middle-click drag

Drag the region, overriding the edit mode.  If the mode is Slide, then
the region will be locked in time and will only move up/down across
tracks.  If the edit mode is Lock, then this will override the lock and
allow the region to slide side-to-side in time

Ctrl/Cmd-click drag Drag the region, while making a copy

left-click on trim bar Trim the start of the region to this point

middle-click on trim bar Trim the end of the region to this point

Ctrl/Cmd-left-click on trim bar
Slide the contents of the audio file inside the region, leaving the region
start and end times intact

right-click anywhere in a region Pop up the Region Context menu (see below)

right-click in the yellow crossfade area Change the shape of the fade in/out



Region Layers

Regions may be stacked on the same location in the timeline.  This is called
"layering".  Normally only the top region is heard; it covers the audio regions
below it.  However there are cases where the region below can be heard.
One example is the top region's fade-in or fade-out.  Region fades operate
as crossfades.  If a region is stacked on top of another region, then the
region underneath will audibly "fade out", while the topmost region "fades in"
across the length of the crossfade.  The second way to hear a region below
the topmost region is if the topmost region is not opaque.  (the Opaque flag
can be turned off in the Region menu and/or the right-click Region context
menu).

Region layering can be changed on-the-fly by the user.  Try right-clicking on
a region to change its layering.  Layering is one way to manage multiple
"takes" of a performance.  Each time a track is recorded, a new region is
written onto the topmost layer.  But the layers underneath still exist.

There are global options that define the default behavior of crossfades and
layers.  While the defaults are suitable for most users, understanding these options can be very important for
advanced users.  (see Crossfade and Layer Modes in Section 26.0 Mixbus Options)

Region Fades

Every Region has a fade-in and fade-out.  By default, the region fade is very short, and serves to de-click the transi-
tions at the start and end of the region.  By adjusting the region’s fade length, a more gradual transition can be
accomplished.  Important:  In Mixbus, each region’s fade is a crossfade with the audio below it.  In other words, if
the beginning of a region overlays a region(s) below it,  you will hear a gradual fade from the underlying region(s),
and a fade-in of the topmost region.

You may right-click on a region’s fade-in or fade-out to choose the shape of the fade.

Deactivate: The fade is completely deactivated. The audio in the region
will be heard exactly as-is.
Linear: Cuts off abrubptly at lower levels.  Used as a crossfade between 2
audio regions.  The signals are each -6dB attenuated at the midpoint. This
is the correct crossfade to use with highly-correlated signals for a smooth
transition.
Equal Power: Used as a crossfade between 2 audio regions. The signals
are each attenuated -3dB at the midpoint. This is the correct crossfade to
use when editing unlike audio together.
Symmetric: This is not mathematically correct like the Equal Power or
Linear curves, but it provides a slower fade-out at low volumes. This is
sometimes useful when editing 2 entire music works together so that the
transition is more gradual.
Fast: Normally used as a region fade-in or -out.  The level is reduced at a
constant-dB rate, so it sounds very smooth.

Slow: Normally used as a region fade-in or fade-out.  Similar to Fast, except it has a less abrupt transition near
unity (top of the fade). This curve is most similar to gradually lowering a fader.  It is well-suited to fading out the end
of a song.

Region Context Menu
The region context menu (launched by right-clicking a region) has many of the same operations as the main Region
menu.  The Region context menu always operates on the single region that was right-clicked on, while the Region
menu operates on all selected tracks.  Many items in the Region Menu are self-explanatory.  
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Tip: By default, regions are
opaque.  Opaque regions are visi-

bly and audibly opaque, meaning you
can't see of hear the region underneath
(except during the crossfade area).  The
right-click menu allows you to disable the
opaque flag, and make the region(s)
"transparent".  Transparent regions are
visibly transparent, allowing you to see
any waveforms beneath the region.
They are also audibly transparent,
meaning that their sound is mixed with
the regions underneath, instead of
replacing it.  This is an excellent way to
work when you are assembling sound
effects that may overlap but do not need
to occlude each other or create cross-
fades.

�



Region Gain
Every region in Mixbus has a level control (called Region Gain in some menus) that applies to the whole region.  The
Region’s level can be modified by the Region menu, or from the right-click context menu:

•  Increase/Decrease Region Gain (Increase is limited to +10dB)
•  Reset Region Gain to Unity
•  Normalize  (Raises or lowers gain so that the highest value in the region is 0dBFS, limited to +10dB max gain)

The Normalize entry will say "Denormalize" if the region is already normalized.  This will return the region gain to
unity.

For a detailed demonstration of region editing and crossfades, watch this video at our YouTube
Channel: http://www.youtube.com/watch?v=aFWfLfrn_vU
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Note: If you normalize a region, it will raise the region gain so that
the waveform shown in the region reaches 0dBFS.  If the region is

extended to represent more of the underlying audio file, this audio may
reach above 0dBFS.

% Tip: Simply point the mouse at the
region and use the gain up/down

key to quickly adjust region gain.  You
can also select multiple regions at once
and then use the region gain key com-
mands to raise or lower all the regions
simultaneously.

�

Note: Mixbus has 5 built-in gain stages in a track:  Region Gain,
Region Envelope, Input Trim, Fader, and Makeup Gain (when com-

pressor is enabled).  Each gain stage serves an important purpose, and the
combination of these stages makes it easy and fun to mix in Mixbus.

%

Region
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Trim
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Object
Area
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(Smart Mode)

Fade In
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Importing Files to Mixbus
Files may be imported to Mixbus by dragging and dropping them from a file browser into the editor window.  Using
the Import window (File->Import) is a much more flexible and powerful way to import files to Mixbus.

The Import dialog has 3 tabs at the top:  "Browse Files", "Search Tags", and “Search Freesound”.

•  The Path Bar:  Shows your current path and allows you to navigate back "up" the directory tree.
•  The Location Bar:  Allows you to directly type in the name of a file in this directory or enter the entire path via
text (the "notebook" button shows or hides the Location bar).
•  Places:  A list of common locations on your computer.  The top two items, "Search" and "Recently Used", are
always there.  Clicking "Search" allows a text entry to search your system.  Warning:  This can take a LONG
time.  The lower section provides shortcuts to commonly-used locations.  You can Add and Remove these loca-
tions using the buttons underneath.  You can also remove or rename locations by right-clicking on them.

The main area shows a list of files in the current directory.  They can be sorted by Name, Size, or Modified Date by
clicking on the headers at the top of the columns.  Underneath is a selector to show "Audio Files" (files with recog-
nized audio file extensions such as .wav) or it can show "All Files".

To the right of the file selector is the file information area.  When a file is selected in the browser, you get a report of
the number of channels, sample rate, and in the case of broadcast wave files, the timestamp when it was recorded.
There is also an area to enter metadata "tags" for the file.  Tagging files this way makes it very easy to find them in
the future.  Finally, there are options to Audition the files.  You can click "Play" to play the file, Stop to stop playing, or
choose auto-play so that files automatically start playing when you click on them.  By default files will play when you
double-click on them.  There is also a level-fader on the right side that allows you to trim the audition level.

The most important buttons are underneath.  These buttons control the modes that will dictate how files are import-
ed.

Add Files:

•  As New Tracks:  Each file will be imported to a new track.
•  To Region List:  The imported files will be imported to the region list but no tracks will be created.  This is use-
ful if you are importing individual hits or effects into the region list, where you will use them to replace existing
sounds.
•  As New Tape Tracks:  Creates destructive "tape" tracks which can be recorded into.  This is not recommended
for most users !!
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Insert:

•  Use File Timestamp:  After importing the file will be located at the file's time stamp (if it is a bwav file).
•  At Edit Point:  After importing the file will be located at the edit point.
•  At Playhead:  After importing the file will be located at the playhead location.
•  At Session Start:  After importing the file will be located at the session's start marker.

Mapping:

•  One Track Per File:  Each file will be appear on one track.  If the file is stereo, it will be a stereo track.  If there
are more than 2 channels then they will be ignored.
•  One Track Per Channel:  Each channel of each file will appear as a track.  If a file is stereo, it will be converted
to 2 mono tracks.  An 8-channel wav file will be converted to 8 mono tracks.

Conversion Quality:  If the file has a different sample rate than the current session, it is necessary to do sample-
rate-conversion.  This determines the quality and it is always recommended that "Best" is used.

Copy Files to session:  IMPORTANT!!  If you want to use a file as-is, you can uncheck this box.  This saves disk
space by not duplicating the file into the session.  No sample-rate conversion is performed.  Your files can sound
sped-up or slowed-down if their sample rate does not match the sample rate of the session. By default, files are
always copied to the session with appropriate sample rate conversion.  If “Options->Always Copy Imported Files” is
enabled, then this option will be grayed-out.

Tags: If you have used the Tag feature to "tag" files that are used in the past, then you can use the Search Tags tab
to find those files quickly.  In this case, we searched for the term "shout" which was added to the files on the previ-
ous page.  They instantly appear in the file area to be auditioned and imported.
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Note:  If a file is "linked" into the session without being copied into the session, then the sound won't be avail-
able if the file is moved or deleted.  For example, if the file is on a removable hard drive then it might not be

available next time the session is used.  Use this at your own risk.

%



Search Freesound:

http://www.freesound.org is an online repository of searchable sound files.  The “Search
Freesound” tab allows you to search the Freesound database, download & audition files from
within the Import dialog.

Tags: enter the “tags” that you would like to search.  You may enter multiple search terms sepa-
rated by spaces.  For example “drums 120bpm” will search for files that are tagged “drums”  OR
“120bpm”.

Sort: Choosing one of the sort options will cause Freesound to order the files before returning
the list of available files.  This can save time if you know (for example) the sound you need is
very short.

Search: Click this button to initiate the search.  Freesound will begin returning pages of informa-
tion, with 20 items per page.  You may click “Stop” to stop downloading.

The file list: Click on a file to download it from Freesound.  Double-click the file to auto-play it in
the auditioner.

Files imported with Freesound will automatically include any Tags that are associated with the
file, and these tages will be included in a search when you use the “Search Tags” tab.

For a demonstration of the file import function of Mixbus, watch this video on our YouTube
Channel: http://www.youtube.com/watch?v=otZgZs3CDYM
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Note:  Files at Freesound are licensed with one of several Creative Commons licenses.  All Creative
Commons licenses allow you to include the sounds in a non-commercial work.  If you wish to use a Freesound

sound in a commercial work, you must abide by the license for the specific file.  Many files only require attribution to
be used in a commercial work, but others have a more restrictive license. Please visit http://www.freesound.org to
investigate the license requirements of the file.
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Audio Consolidation and Export
Mixbus has multiple ways of “rendering” audio into contiguous audio files.  Tracks may be consolidated so that all
regions (including crossfades, fade in/out, and region gain) are rendered into a single region.  Right-click on any
track and select Consolidate for this function.  Or select multiple tracks and choose the Consolidate function from the
Track menu.  Consolidated tracks use the session start and end time as the length to consolidate.  Mixer functions
such as fader and plug-in settings are not rendered into the consolidated regions.

A region can be bounced from the right-click context menu.  A new region will be created in the region window which
has the fades and gain automation applied.  This is useful for drum hits or sound effects that are to be reused later in
the project.
Using the range tool then right-clicking on the range will launch the Range Context Menu.  Selecting Consolidate

Range will take all the regions in the range, apply gain automation and fades, and render into a single new region in-
place.  Export range will render the selected tracks through the master outputs and create a stereo output file in the
“exports” subfolder of the session.

Finally, Session->Export->Export Session to audio file will export the entire session, as you hear it, to a stereo
wav file.  It is also possible to export individual track “stems” from this dialog for processing in another workstation.

The Export Session operation depends on the session having correct start/end times.  You can drag the start/end
markers in the marker bar, or open the Locations dialog to edit them (and other markers including CD markers)
manually.  When exporting a project as a CD, you will want to use CD markers so Mixbus will generate a TOC (table
of contents) text file for the CD.  An alternative method is to make range markers, and then use Session->Export-

>Export range markers to audio file.  This allows you to export ranges that are non-contiguous, overlapping, or

even nested.

Exporting to a File
Once a mix is ready for delivery, you will need to generate a final output from Mixbus.

Initiating an Export

There are several ways to initiate an Export from Mixbus.  The different ways of initiating an export define the start
and end times of the session will be. (the choice of which tracks/buses to export will come later)

•  Export Session to Audio File (the most common option):  This exports the entire range from the Start marker to
the End marker.
•  Export Selected Range to Audio File:  This exports the current Range selection to an audio file.  (Note:  this
can also be triggered by right-clicking on the selected range and choosing "export range")
•  Export Selected Regions to Audio File:  This exports a length of time starting at the first selected region, and
continuing to the end of the last selected region.
•  Export Range Markers to Multiple Audio Files:  This very powerful feature allows you to export several ranges
(songs) at one time.  The resulting files will use the region names as the file names.

Once the export is initiated, you must choose the location and format of the exported file.
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Export to File: Enter the path and file name that you wish to create.  This defaults to the sessions "export" folder.
Click "Browse" to see a file browser and navigate to a different folder.

Format:

•  Export Source: Choose “Master Output” to export the
master bus output of Mixbus. If you want to export indi-
vidual tracks separately, or control the Left/Right assign-
ment of tracks to the file, click “Custom Selection” (see
below for more details)
•  Channels:  Chooses whether the resulting file will be
Stereo or Mono.
•  File Type:  Format of the resulting files (the list
depends on the system's available options).  For CD-
quality, choose WAV
•  Sample Format:  The “32-bit” setting means 32-bit inte-
ger format.  This is ultra-high resolution but does not
accommodate signals over 0dBFS.  The "float" setting is
32-bit floating point which accommodates signals over
0dBFS which is preferred in most cases.  For CD-quality
audio choose 16-bit.
•  Sample Endianness:  This is only enabled if the file for-
mat allows a choice.  Choose Little Endian or Big Endian
(PowerPC).
•  Sample Rate:  For CD-quality audio choose 44.1kHz.
•  Conversion Quality:  This is only enabled if the export
sample rate is not the same as the session.  The setting
"best" is recommended.
•  Dither Type:  None, Rectangular, Shaped Noise, or
Triangular.  The "None" or "Shaped" settings are recom-
mended.
•  CD Marker File Type:  CUE & TOC.  These file types
may be utilized by CD-burning software to define track
indexes, track names, and other metadata.  

Soundcloud Export:

Soudcloud is an online service that hosts your audio files for others to browse, search, and annotate.  Uploading files
to Soundcloud is an easy way to get your music posted to the Internet without having to encode the file and transfer
it to a server.  For faster uploads and best quality, it is suggested that you export files in the FLAC format before
uploading to Soundcloud.

•  Also Upload to Soundcloud:  Enable this option to automatically upload the file to Soundcloud.com
•  Make file public:  The resulting Soundcloud object will be available for the public to view if this is turned on.  If
not, the file will only be visible to you.
•  Track Title:  The name that this item will have on Soundcloud.  This defaults to the session name.
•  User Email:  This is your user name for Soundcloud.  This defaults to the User Email stored your Metadata
settings ( see section 19, Metadata )
• Password:  Souindcloud user password is required to upload files to Soundcloud.

The black bar at the bottom of the window is the progress indicator.  The progress indicator displays the progres of
the file export as well as Soundcloud upload, if engaged.  If “Also Upload to Soundcloud” is engaged, then a
browswer window will open to display the file at Soundcloud.comwhen the upload is completed.

You can cancel an Export operation at any time by closing the dialog and/or clicking Cancel.
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Custom Selection:  You can also export the output from a single track (the "direct out" of the track/bus).  The output
of the tracks should be assigned to one or both sides of the export file.

When “Custome Selection” is engaged, the right-hand side of the dialog will display a list of all available tracks and
buses.  Stereo tracks and buses will appear as 2 separate items, with “out-1” indicating left, and “out-2” indicating
right.  Place checkmarks to assign the track or bus output to the exported file’s channels.

IIf Mono is selected for the “Channels” option, then only a single checkbox is provided for each track/bus.  

For a demo of exporting, watch this video on our YouTube Channel: http://www.youtube.com/watch?v=wddiGR-Y1bk
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Note:  Multiple tracks/buses may be assigned to a single channel of an export file. For example, you can
assign both the left and right channels of the Master Bus to a mono file.  However please note that no level

compensation is provided. If the summed level of the tracks exceeds 0dBFS and the format is not 32-bit floating
poinnt, then the exported file can have “clipped” audio samples which may cause audible distortion.
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Session files include “metadata” which can include information about the project including the composer(s), engi-
neers, etc.  Metadata is stored inside the session file in a simple XML format.

The Metadata dialog is launched from the Session menu:

The User page includes information about the primary user of Mixbus.  This includes the Name, Email, Web,
Organization and Country information.  This information is purely for convenience and for documentation purposes.
There are 3 specific ways that this information is used within Mixbus:

Email:  automatically entered into the Freesound entry box in the Export dialog.
Organization:  This text is stored in broadcast wave file metadata
Country:  This text is stored in broadcast wave file metadata 

The User information is stored outside the session file and is persistent across sessions.

The remaining tabs ( Track, Album, People, and School) record data that is stored in the session file.  The data is
stored in an industry-standard XML format, and can be easily read and manipulated by 3rd party applications or
scripts.  Contact Harrison if you are interested in further development of Mixbus metadata.
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Clocks
Mixbus provides two clocks which display the current position of the playhead.  Having 2 clocks is a convenience:
you can leave one clock showing "musical" time (such as bars/beats) while the other clock shows time in hours:min-
utes:seconds.

Right-click on a clock to change the mode of the clock.  A menu
appears with the available options

Some clock modes have smaller sub-displays which show the current meter/tempo, SMPTE format, or sample rate
(in applicable modes).

It is possible to click on a clock and directly enter a timecode location directly.  Pressing "Enter" will locate the play-
head to the new time.

Synchronization
Mixbus allows selection of several synchronization sources: Internal, MTC, and JACK

•  Internal:  The playhead position is defined by Mixbus;  all
transport commands come from Mixbus.
•  MTC:  The playhead position and transport state will be deter-
mined from incoming MIDI Time Code.
•  JACK:  The playhead position and transport state will be
determined from JACK.  Transport commands initiated from
Mixbus will be applied to all JACK-synchronized programs.

•  Time Master (JACK only):  Only one JACK-synchronized program can be the "Time master".  When JACK
sync is used the timelines of the synchronized programs are located using the sample-clock offset.  Since differ-
ent programs may have different tempo maps, or methods of handling musical time, the "time master" identifies
the machine that will define the musical time (bars/beats) position of the song.  This is for advanced users only.
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Note:  There are several other clocks in Mixbus, such as the
Nudge clock and the SMPTE offset clock.  These clocks can

also be set to any mode, so you can (for example) set the nudge
clock to advance in bars:beats instead of minutes:seconds.

%

Note:  A list of JACK-aware programs is listed at:  http://jackaudio.org/applications%



Defining a Song's Tempo and Meter
Mixbus allows simple creation and editing of a musical time/tempo map for each session.  The meter and tempo map
is controlled with the Meter and Tempo rulers.  To show these rulers, right-click in the ruler area underneath the
transport buttons and check the boxes for the Meter and Tempo rulers. Alternatively, you can use the View menu to
hide/show the rulers.

There are 2 reasons that you might want to set the Meter/Tempo for your song:
1.  To record with a "click" or metronome to help maintain consistent time among different performers and parts.
2.  To use the Grid to facilitate editing (if the audio follows the tempo map of the song).

By default, Mixbus starts with the tempo set to 120bpm and 4/4 time signature.  In
many cases, you will use a single tempo for the entire song.  In this case you will
right-click on the existing markers and set the tempo to the desired tempo and
time signature.  Right-clicking in the Meter/Tempo rulers allow you to create new
Meter or Tempo markers.

Using the Click
To play click (metronome) sound during playback and recording, enable the
"Click" button near the top-right of the edit window.  The rate of the click is
defined by the session's Tempo and Meter rulers. The sound of the click can
be modified from the Preferences Window  (see the section on
Preferences).

Using the Grid

Editing with the "Grid" allows you to make edits perfectly aligned with other events.  If the grid is set to musical time
(and the audio was recorded to a click)  then editing can be done very quickly without zooming in, because you know
all edits will happen on a musically-sensible time.  Setting the Grid to SMPTE frames will guarantee that all edits
happen in sync with the video frames, etc.
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Tip:  Here's an easy way to set the
tempo for a song:  record a portion

of the song, and then select one bar with
the Range tool.  Now click "Tempo->Set
Tempo from Edit Range" to set the
tempo.

�Note:  Currently, Meter and Tempo changes can only occur at the
beginning of a new measure, so that the beats stay lined up.

%

Tip:  It is common practice to leave
some time at the beginning of a

song, rather than starting from the zero
indication.  Some common choices are 8
measures, 1 minute, 10 minutes, or 1
hour.  This allows space at the beginning
of the song to add an intro, place a sync
click or test tones, or just make editing
easier by allowing some unallocated
space at the beginning of the track.

�

Note:  Some DAWs use the term "Snap" instead of "Grid".  We use the term "Grid" to refer to the settings, and
"snap" to refer to the operation of the Grid on the edit point.
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The settings for the Grid menu are:

•  No Grid:  No grid is applied.
•  Grid:  the grid is applied;  any mouse move in the editing canvas will
"jump" between grid locations.  Operations at the Edit Point will be
snapped to the nearest grid point.
•  Magnetic:  When the Edit point is very near a grid location, it will snap
to the location.  But  in-between the locations it will remain manual (no
grid).

Grid Modes

The edit point may snap to:

•  clock time  (CD frames, SMPTE, Seconds, Minutes)
•  Musical Time (Bars, Beats)
•  Markers 
•  Region events (start, stop, etc)
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Note:  To use Region starts/ends/syncs/bounds as snap choices, you must have either (a) NO tracks selected,
which means that Mixbus will snap to regions on any track, or (b) several tracks selected, and Mixbus will only

snap to regions on those selected tracks. If you are moving items on a track, and only the current track is selected,
then you will only be able to snap to other regions on the same track.  This means that the Option "Sync Track
Selection to Region Selection" will make the "Region" grid units unusable.  Avoid the use of this option if you are
going to use any of the Region grid units.

%

Note:  Regions have a  "Sync
point" which defines how they will

snap to the grid.  For example: a region
might have audio preceding the first
note, but the first note defines the point
that should by synchronized to the grid.
The "sync position" can be changed with
Region->Set Sync Position, or the
assigned keyboard command.  You may
need to turn off the Grid when assigning
sync points, if the sync point isn't already
lined up on a grid location.

�



Monitoring
"Monitoring" is the process of hearing the prerecorded tracks (and/or yourself) while the transport is playing.  There
are several options that control how Mixbus should monitor the inputs of each track.

Audio Hardware Does Monitoring

This option is best used with audio interfaces that have the ability to monitor the inputs to the interface.  Some inter-
faces come with a software application to control this while others may have a knob or button on the interface to
allow direct monitoring.  Additionally, other interfaces may need to be configured using the operating system’s vol-
ume control application.

Mixbus Does Monitoring

This setting is also known as “software monitoring”.  With this setting, when Mixbus is recording audio it will route the
inputs of the record-enabled tracks through the tracks instead of playing back the previously recorded audio.  This is
best used on systems that work well with very low buffer sizes (256 at 44 or 48KHz or 128 at 96KHz).  Very small
buffer sizes are used to minimize the monitoring latency.

JACK Does Monitoring (Linux Systems Only)

On some systems JACK is able to directly route the audio inputs to the audio outputs.  This combines the low-laten-
cy of hardware monitoring with the features of software monitoring.

Tape-Machine Monitoring

This mode applies when using Mixbus or JACK to control the monitoring.

Mixbus Monitoring Modes Chart

The chart on the next page shows how the monitoring interacts with various settings in Mixbus.
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Monitor Mode 
Is The Track

Rec Enabled?

Is The Master
Rec Enable

On?

Auto Input
Status

Transport
Mode

Meter Monitor 

Normal No No On Stop Input Input 

Normal No No Off Stop Track (silence) Track (silence) 

Normal No No On Play Track (Audio) Track (Audio) 

Normal No No Off Play Track (Audio) Track (Audio) 

Normal No Yes On Stop Input Input 

Normal No Yes Off Stop Track (silence) Track (silence) 

Normal No Yes On Play Track (Audio) Track (Audio) 

Normal No Yes Off Play Track (Audio) Track (Audio) 

Normal Yes No On Stop Input Input 

Normal Yes No Off Stop Input Input 

Normal Yes No On Play Input Track (Audio) 

Normal Yes No Off Play Input Input 

Normal Yes Yes On Stop Input Input 

Normal Yes Yes Off Stop Input Input 

Normal Yes Yes On Play Input Input 

Normal Yes Yes Off Play Input Input 

Tape Machine No No On Stop Track (silence) Track (silence) 

Tape Machine No No Off Stop Track (silence) Track (silence) 

Tape Machine No No On Play Track (Audio) Track (Audio) 

Tape Machine No No Off Play Track (Audio) Track (Audio) 

Tape Machine No Yes On Stop Track (silence) Track (silence) 

Tape Machine No Yes Off Stop Track (silence) Track (silence) 

Tape Machine No Yes On Play Track (Audio) Track (Audio) 

Tape Machine No Yes Off Play Track (Audio) Track (Audio) 

Tape Machine Yes No On Stop Input Input 

Tape Machine Yes No Off Stop Input Input 

Tape Machine Yes No On Play Input Track (Audio) 

Tape Machine Yes No Off Play Input Input 

Tape Machine Yes Yes On Stop Input Input 

Tape Machine Yes Yes Off Stop Input Input 

Tape Machine Yes Yes On Play Input Input 

Tape Machine Yes Yes Off Play Input Input 



The Locations window provides another view of the Location Markers, Loop Range, Punch Range, Ranges, and CD
Ranges that appear on the "rulers" of the Editor window.  This window allows you to see all of the existing markers in
one window with all of the parameters displayed.

•  Go:  Moves the Playhead to the associated Marker or the start/end of the associated Range.
•  Use PH:  Assign the current playhead location to the marker or the start/end of the associated Range.
•  Hidden:  Markers and ranges may be shown or hidden.
•  CD:  For locations, this is CD Indexes.  For ranges, this indicates that the range represents a CD Track.

Items with the CD box checked will also get the ISRC, SCMS, Pre-emphasis, Performer, and Composer entry boxes
which will be incorporated into the CUE/TOC file during session export and can be imported by CD burning software.
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The Rhythm Ferret dialog provides a method to quickly "split" an audio region (or selection of regions) based on
events.  This can be useful when separating a recorded performance into its component strikes or notes for further
editing.

•  Mode:  Determines whether the Ferret will trigger on percussive onsets for
unpitched percussion instruments), or note onsets (for pitched instruments).
•  Threshold, Sensitivity:  adjust these parameters to refine the detection of
events
•  Trigger gap:  the shortest distance between events that the Ferret will allow.
Increase this number if you get multiple triggers on a single note.
•  Analyze: displays the results of the analysis on the selected track(s).

Once you are satisfied with the points that the Ferret has chosen to split, you can
click "Split on Onsets" to automatically split the selected regions on the marks.
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On OSX, you will find the Preferences window under the menu item Mixbus->Preferences. On Linux & Windows, you
will find it under Windows->Preferences

The preferences window has several tabs.  Each is described below:

Plugins ( WIndows Only )

•  VST Path:  the VST path is a list of directories that Mixbus will use to scan for plugins.  This path may not be
directly edited by the user, but can be cleared, added to, and set to defaults with the buttons below it.
•  Clear Paths & Cache:  Clicking this button will erase the VST path box.  It also clears the “cache” which is a
list of plugins that have been scanned.  Mixbus will only load plugins that have been scanned and are in the
cache.  So clicking this button will VST plugins in Mixbus until paths have been scanned.
•  Clear Blacklist:  When a plugin crashes on scanning, it is placed in the “blacklist” and will not be scanned in
the future.  Click this button to clear all blacklisted plugins so they can be scanned.
•  Set Defaults:  This will set the VST path to those folders that are defined as VST paths in the Windows system.
This includes paths set in the registry as well as the environment variable VST_PATH.
•  Add VST Directory:  Clicking this button will allow the user to select a folder which contains VST plugins.
Highlight the folder and click “OK” to select a plugin folder and add it to the VST path.
•  Scan for plugins:  Click this button to initiate a “scan” along the paths listed in the VST path box.  A popup dia-
log window shows the progress of the scan operation.

Sync ( OSX & Linux Only )

•  SMPTE Offset:  If you set a time in this clock, Mixbus will apply this offset to SMPTE time (via MTC) that is
sent and received.  "SMPTE offset is negative" indicates that the time should be subtracted to the timeline, rather
than added.
•  Timecode Source is Sample-clock synced:  This indicates that, once Mixbus and the external device are
synced, it can be assumed that they will stay in sync without any varispeed because they are being fed from the
same digital clock.

Paths/Files ( OSX & Linux Only )

•  Session RAID path:  This feature is used to split a session's audio data onto 2 separate drives, maximizing
throughput.  With modern hard drives, this is normally unnecessary.

Click

This is where the click sound is defined.

•  Click audio file:  browse to define the soundfile for the "click".  If no soundfile is defined, Mixbus will use an
internally-generated click sound.
•  Click emphasis audio file:  browse to define the soundfile for the "emphasis click".  The emphasis click occurs
on the first beat of each measure.
•  Outputs & Available Connections:  these controls are similar to the track outputs:  you can route the Click to
anywhere in your system, and set the level of the click sound.  The Click is stereo;  by default, the left signal is is
connected to the first two "physical" outputs of your soundcard.  The click does not appear in the "master" bus or
in the exported audio, unless you re-route it into a track/bus manually.

Audition

This is where you define the outputs of audio that is "auditioned".

There are several ways to "audition" audio through Mixbus.  You might audition a region in the region list that is not
yet assigned to a track, or you might audition a soundfile that you are considering for import.

The auditioner controls are similar to track outputs.  You can route the Auditioner anywhere in your system, and set
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the level of the audition.  The auditioner is stereo;  by default, it is connected to the first two "physical" outputs of
your soundcard.  The Audition does not appear in the "master" bus or in the exported audio, unless you re-route it
into a track/bus manually.

Misc

•  Edit Audition Preroll:  (only active when Join Playhead option is enabled).  When Join-Playhead is enabled,
many editing operations will automatically locate the playhead so that the recent edit can be auditioned.  This
defines the time (in seconds) that the playhead will pre-roll before the edit is heard.
•  Font scaling  (Linux only):  This allows all the text of the Mixbus screen to be scaled larger or smaller, on the
fly.  Very small text will allow more features to be shown on a very small screen, such as a netbook.
Alternatively, very large text might be useful for those with poor vision or who use a computer monitor that is far
away.
•  Short crossfade length:  When 2 regions are overlapped, this defines the length of the crossfade on the top-
most region that is automatically generated to minimize the sound of the junction.
•  Destructive crossfade length:  When using destructive (tape) tracks, this defines the amount of crossfade when
a new sound is "punched in" over the old sound in a wave file.
•  Limit Undo History:  This should be enabled to limit the memory and disk space that Mixbus will use to store
Undo information.  Select a number of operations that you'd like Mixbus to remember.
•  Save Undo History:  This should be enabled if you would like Mixbus to remember your Undo history for each
snapshot file, so that when you open a session or snapshot, the Undo history is preserved from the last time you
were using it.

MIDI  ( NOTE:   Linux and OSX only )

Although at this time Ardour does not support MIDI sequencing, it does support a fairly rich set of interactions via
MIDI with other devices, in particular:

•  Ardour can function as MIDI Time Code (MTC) master or slave. MTC is used to transfer the actual time loca-
tion, so the connected MIDI devices will stay in sync (even when using fast forward and such).
•  Ardour can control or be controlled by other devices using MIDI Machine Control (MMC). MMC commands
include start, stop, punch in, punch out and others.
•  In Ardour, virtually any parameter can be controlled by MIDI Continuous Controller (CC) messages (which is
called MIDI Parameter Control). In addition, Ardour can send MIDI "feedback" so that external motorized control
surfaces can reflect parameter changes caused by automation etc.

MIDI Ports

Mixbus does not attempt to discover what physical MIDI ports exist on your system.  Instead, Mixbus publishes ports
which can be connected to any other system MIDI port using a 3rd-party MIDI router.
By default, three MIDI ports will be available.  One for MTC timecode in/out, one for Mackie MCU fader controllers,
and one for "Generic MIDI" control surfaces.

•  Online:  Setting a port to offline will not cause a port to disappear; rather Ardour will simply no longer send any
data on it, nor will it process data received on it. Online ports work normally.
•  Trace Input, Trace Output:  When checked for a port, the sent (Output) or received (Input) MIDI data will be
displayed on the console.  This is a troubleshooting tool if you aren't sure that you are sending or receiving MIDI
messages.
•  MTC, MMC, MIDI Parameter Control:  You can choose which port is used for which kind of MIDI information.
For each kind - MTC, MMC and MIDI Parameter Control - one MIDI port have to be assigned. The same MIDI
port can be used for several kinds of information.
•  Remove:  This button will remove the associated MIDI port.  Note that you cannot remove a port that is
assigned to a task.
•  Add New MIDI port:  Create a new virtual port, which can be assigned to one of the tasks above.  This is rarely
used.
•  Inbound MMC Device ID: Each MMC command includes a device ID. Ardour listens only for MMC commands
with a specific device ID. You can configure for which device ID Ardour listens. The default of 0 should be safe.
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•  Outbound MMC Device ID:  Each MMC command includes a device ID. You can configure which Device ID
Ardour uses when it sends MMC commands. The default of 127 should be safe.
•  Startup program change:  On startup, Ardour sends a Program Change (PC) command. A PC command
includes a program number (a value between 0 and 127). You can choose which program number is sent by
Ardour. A value of -1 will send 127. The default is 127.

The PC command is sent on the MIDI port which is configured to handle MIDI parameter control. It is sent right after
you start a session (either a new one or an existing one). The command is also sent if you choose to load another
session without closing Mixbus.

•  MIDI connections:  Mixbus does not come with any way of establishing MIDI connections from/to other soft-
ware MIDI ports.  On OSX/CoreMIDI you need to connect the MIDI ports with a patchbay tool such as the excel-
lent MIDI Patchbay from Pete Yandell .  On Linux, qjackctl (the same program that is recommended for control-
ling JACK) also includes an excellent MIDI connection manager. You could also use command line tools such as
aconnect. 
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Menu Options
Audio File Format:  Sample Format

The audio data format that Mixbus uses internally.  New recordings will be stored in this format, and files will be con-
verted to this format when imported. 

•  Float (floating point 32-bit) (default value) Allows extra headroom above 0dBFS for JACK-enabled connections
and/or bounces within Mixbus.
•  24-bit:  If you plan to record live sources from a A/D converter and do not use internal bouncing-to-disk, then
24-bit will save some disk space.
•  16bit:  If working with audio sourced from a CD, this uses half the storage space of "float" option. 

Audio File Format:  File Type

The file type that Mixbus uses internally.
•  Broadcast Wave:  Industry standard .wav files with an additional time-stamp that may be used in some soft-
ware.  File size is limited to 4GB.
•  Wave:  Industry standard PCM file.  File size is limited to 4GB.
•  Wav64:  Industry standard PCM file.  Uses 64bit length value in the header allowing nearly limitless recording
length at any sample rate.
•  CAF:  Same as Wav64, but this format is only common on OSX.

Sync:  Send MTC  ( OSX / Linux only )

Send MTC (MIDI Time Code) from a MIDI port.  Can be used to maintain sync with an external drum machine,
sequencer, video player, or other MIDI device.

Sync:  Send MMC ( OSX / Linux only )

Send MMC (MIDI Machine Control) from a MIDI port.  Can be used to start/stop drum machines, video players or
other MIDI devices.

Sync:  Use MMC ( OSX / Linux only )

Mixbus will respond to MMC machine commands (stop, play, record-arm, etc).

Sync:  Timecode ( OSX / Linux only )

This selects the SMPTE timecode format for the session, including "drop" formats and HD formats.  For more infor-
mation see http://en.wikipedia.org/wiki/Frame_rate

Sync:  Pullup ( OSX / Linux only )

In professional video post-production, pullup/pulldown is sometimes required to accommodate the differences
between film and video rates.

Sync: Subframes ( OSX / Linux only )

SMPTE clocks may be separated into 80 or 100 subframes (for display purposes only).

Control Surfaces:  Remote ID ( OSX / Linux only )

•  Remote User Defined:  Remote controls, such as MMC, will number the tracks according to the user-specified
Remote Control ID chosen for each track/bus.
•  Remote Mixer Defined:  Remote controls, such as MMC, will number the tracks according to their order in the
Mixer window.
•  Remote Editor Defined:  Remote controls, such as MMC, will number the tracks according to their order in the
Edit window.

Control Surfaces:  Auto Rebinding ( OSX / Linux only )

If using a MIDI fader controller, this should be ON.

Control Surfaces:  Feedback ( OSX / Linux only )

Some generic MIDI controllers have indications for the current setting of a knob.  If you controller has this feature
then this should be ON.
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Control Surfaces: Mackie ( OSX / Linux only )

If you are using a Mackie Logic protocol control surface then this should be ON.

Control Surfaces: Generic MIDI ( OSX / Linux only )

If you are using a generic MIDI controller to control Mixbus knobs then this should be ON.

AutoConnect ( OSX / Linux only )

•  Auto-connect Inputs to Physical Inputs:  When a new track is created, Mixbus will automatically connect the
next available physical input to the track.
•  Manually Connect Inputs:  When a new track is created, Mixbus will leave the Input un-assigned and the user
must assign it manually before trying to record.

Monitoring

See section 21.0, "Monitoring"

Metering: Fall Off Rate

The decay rate of audio meters, ranging from Off (instant decay) to Slowest (6.6dB/sec decay rate)

Metering: Hold Time

The hold time for the peak-hold indicators.  Ranges from Off (no display) to Slowest (5 second hold).  Note:  This is
only shown in Mixbus for compatibility with Ardour.

Solo

Soloing a track will mute all non-soloed tracks.
•  Latched:  (default ON) If this is on, then multiple tracks may be soloed at once.  If this is OFF, then Soloing a
track will un-solo previously soloed tracks (only one solo allowed at a time).
•  Solo In Place:  (default ON)
•  Solo Via Bus:  (default OFF) The Solo signal will appear at the "Control Output", if one is configured (note:
only shown in Mixbus for compatibility with Ardour).
•  Show Solo Muting:  (default OFF) If this is ON then when a solo is engaged, non-soloed tracks will show a
mute indication.
•  Solo Overrides Mute:  (default OFF)  This allows the track to be heard when soloed, even if the track's Mute is
engaged.

Crossfades

See section 15.0 Editing Tools & Modes for more information about crossfades.
•  Crossfades Active:  (default ON) This is only provided for compatibility with old sessions.  Mixbus no longer
uses separate crossfades.
•  Crossfades Auto:  (default ON) This is only provided for compatibility with old sessions.  Mixbus no longer uses
separate crossfades.
•  Use Region Fades:  (default ON) If this is off, then region fades will be ignored and all regions will start and
end abruptly.
•  Automatic:  (default OFF) When 2 regions are overlapped the top region will have a fade in/out assigned that
covers the entire length of the overlap.  If you trim a region to create more or less overlap, the fade length will
automatically change to cover the whole overlap. 
•  Manual:  (default ON) Fade lengths don't change when an overlap is created.   The user can trim the topmost
region without snapping to the "full crossfade" lengths. 
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Layering

Every region in a playlist has a "layering order" which defines the stacking order of regions.  The topmost region is
the one that is seen and heard.  See section 15.0 Editing Tools & Modes for more information on layering.

•  Automatic (Later is Higher):  (default OFF) This is the most "automatic" mode.  In this mode, the later region (in
time) is always a higher layer.  This works well for simple cases but does not allow manual tweaks when layering
does not work for you.
•  Semi-Auto (Last Moved/Added is Higher):  (default OFF)  In this mode the last added or moved region is
always brought to the top layer.  Additional changes may be done manually.
•  Manual  (Most Recently Added is Higher) (default ON):  This is the most manual method.  Newest regions are
always highest, dragging a region does not change it's layering, and the only changes to layering must be done
manually.

Performance

•  Stop Plug-ins With Transport:  Plug-ins will be disabled when the transport is not rolling.  This reduces cpu
load when you are not actively playing.  Not recommended.
•  Do Not Run Plug-ins While Recording:  Reduces CPU load when recording but plug-ins cannot be heard.  Not
recommended.
•  Denormal Handling:  These options are sometimes used to fix and/or troubleshoot troublesome plug-ins.  Only
use this option when directed to by Harrison Consoles.

Misc. Options
Seamless Looping

Seamless looping creates a crossfade on all tracks between the end and the start of the loop.  This causes a CPU
spike at the end of a loop, but it is recommended if clicks during loops are troublesome.

Use OSC  (OSX / Linux only)

Accept commands via OSC  (Open Sound Control, an ethernet-based remote control protocol).

New Plugins are Active

If this is enabled then a newly-added plug-in will be immediately active after instantiation.

Rec-enable stays engaged at stop

Normally, the master Rec enable is disengaged when the Transport is stoped and it must be re-enabled before
recording again.  If this option is enabled, the Master Rec enable will not be disengaged by Mixbus.

Region Equivalents overlap

Normally, if two tracks are put in an Edit group, and you grab a region on one track, you will only select a region on
the grouped track(s) if they have EXACTLY the same start and stop times (i.e. the tracks have been edited identical-
ly).  If this option is enabled then a click in one track will select any regions that overlap that time on the grouped
tracks.

Periodic Safety backups

If this option is enabled then Mixbus will store a backup of your session approximately every 5 minutes.  There is
only one backup file.

Verify Remove Last Capture

If this is turned on, Mixbus will prompt to make sure you want to delete the last capture (a destructive event).

Stop Recording on Xrun

Xruns are caused by the computer being unable to keep up with the soundcard.  If this option is ON, Mixbus will stop
recording whenever an xrun is encountered so that the user can re-take the recording without glitches.  For long-
form recordings it is probably more important to catch as much as possible so this option should be left OFF.
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Create marker on Xrun

If this option is ON then Mixbus will put a "marker" at each xrun encountered during a recording.  This is useful when
making a long-form recording.  The user can examine the xruns after the fact and try to fix and/or hide them.

Stop Transport at Session End

If this option is ON then the transport will automatically stop when it hits the session End marker.  Note that this does
not affect recording.  When recording the End marker will be pushed farther out.

-12dB gain reduce during ffwd/rewd

If this option is ON then Mixbus will reduce the master output level during varispeed playback that is more than 2x
speed in forward or backwards direction.

Primary/Secondary Clock Delta to Edit Cursor

Selecting this option will make the Primary/Secondary clock show the Delta (difference / distance) between the edit
cursors (see "implicit ranges”).

Always Copy Imported Files

If this is selected then a drag/drop operation will always result in the file being imported (with any needed SRC or bit-
depth change). If this is off then drag/drop files will be used in-place.

Link Region/Track Selection

If enabled selecting a region will also select the track where the region is located.  However, this will disable any
other tracks that were selected for editing.

Name New Markers

By default markers are created with a number and may be renamed manually later.  If enabled new markers will be
immediately prompted for a new name. 

Rubberbanding Snaps to Grid

Rubberband-selecting will auto-snap to the nearest grid.

Auto-Analyze New Audio

If this is checked any imported or recorded audio will be analyzed so that the region can be navigated using jump-to-
transient operations.  If this is not checked then the user will be prompted to analyze a file whenever jump-to-tran-

sient is used.
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Mixbus can utilize generic MIDI control messages to control some common editor and mixer parameters.

You will need to use an OSX "midi router" such as http://notahat.com/midi_patchbay ( OSX only )to connect from
your MIDI interface to the ports of Mixbus.

You can see the various MIDI ports, and control their operation, in Windows->Preferences->MIDI. 

All gain faders, panners, mute/solo/rec-enable buttons and all plug-in parameters can be controlled by MIDI
Continuous Controller (CC) (which is called MIDI Parameter Control in Ardour).  Mixbus can also send MIDI "feed-
back" whenever gain, pan or plug-in states change so that external motorized control surfaces can reflect parameter
changes caused by automation etc.  In addition, MMC commands are supported.  Generic MIDI control surfaces do
not use the MCU protocol.

To use a generic MIDI control surface in Ardour, choose the "Options" menu, then choose the "Control Surfaces"
submenu, then select "Generic MIDI".

Mixbus can send feedback to the control surface, allowing it to reflect changes caused by automation or by mouse
interaction. You can enable feedback by choosing the "Options" menu, the "Control Surfaces" submenu, the
"Controls" submenu, then selecting "Feedback".

To control e.g. a gain fader, use Ctrl/Cmd+Button2 (button2 is the "middle" button of a 3-button mouse) on the fader.
The message "operate controller now" should appear. Move the desired fader or knob on your control surface. The
fader on the screen should start to move as you move the slider on your control surface. If you activated MIDI feed-
back and your control surface supports it, it should reflect changes you do with the mouse.

Mixbus accepts Change Control (CC) MIDI commands. Those commands can be sent on arbitrary MIDI channels.
Faders and other continuously moved controls are controlled with CC commands with a range of 0-127. Buttons (e.g.
Mute buttons) are also controlled with CC commands, where a value of 0-63 switches the button off and a value of
64-127 switches the button on.

Mixbus also receives and sends some MMC commands, such as play, stop, locate, punch in and punch out.

To receive simple MMC transport commands from an external device, enable Options->Sync->Use MMC and con-
nect your device to Ardour's "control" input port.

To use Mixbus as an MTC master, enable Options->Sync->Send MMC, and connect your device to Ardour's "control"
output port.  Normally you will want the digital recorder/player (Mixbus) to be the sync Master. If you want Mixbus to
act as an MTC slave, route your MTC signal into the Ardour "control" port.  Then switch Ardour's sync source to
"MTC" at the top of the edit window next to the main clock. 
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Controls
Each Mixer Strip features control of the channel's fader, stereo pan, rec-enable, mute, and solo.

The Jog wheel has various modes:

•  Scroll mode. Part of the Scrub button cycle. The default. Scrolls the playhead. Displays "SC" in the 2 character
LED.
•  Scrub mode. Part of the Scrub button cycle. Rate of rotation of the Jog wheel controls the direction and speed
of the transport. Displays "Sb" in the 2 character LED.
•  Shuttle mode. Part of the Scrub button cycle. Jog wheel controls speed and direction of transport. Displays
"Sh" in the 2 character LED.
•  Zoom mode. Toggled by the Zoom button. Mutually exclusive with the Scrub cycle. Jog wheel controls zoom
level. Displays "Zm" in the 2 character LED.

When holding ffwd or rew, the Jog wheel will adjust the speed.

frm_next and frm_prev will jump to next or previous markers. Markers can be set at the current playhead position
with the marker button.
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Mixbus has a standard keyboard shortcut layout that provides alternate keystrokes that are available in other digital
audio workstations.  In the following tables, “NumPad” is used to reference the number pad on the right side of the
keyboard.
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Standard Mixbus Layout Alternate 1 Alternate 2

Transport and Recording Control

Standard Mixbus Layout Alternate 1 Alternate 2

Session and File Handling

roll playhead spacebar NumPad 0

roll record Shift+space NumPad 3

stop and destroy Control+space

destroy last recording Control+Delete

rewind Shift+leftarrow NumPad 1

fast forward Shift+rightarrow NumPad 2

transition to reverse Shift+downarrow

transition to play Shift+uparrow

toggle auto play 5

toggle auto return 6

toggle click 7

toggle auto input 8

toggle follow playhead Control+f

toggle track rec-enable Alt+r

toggle master rec-enable Shift+r

set playhead p

play selected region(s) h

loop play (the loop range) l NumPad 4

key focus on main clock NumPad /

start a new session Control+n

open an existing session Control+o

open a recent session Control+Shift+o

save session Control+s

save session as Control+Alt+s

save session snapshot Control+Shift+s

add track(s) / bus(ses) Alt+n

import audio files Alt+i

export session Alt+e

quit Control+q

Standard Mixbus Layout Alternate 1 Alternate 2

copy Control+c
cut Control+x
delete Delete BackSpace
paste Control+v
redo Control+r Control+Shift+z Control+y
undo Control+z
quit Control+q

Common Functions
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Standard Mixbus Layout Alternate 1 Alternate 2

Changing What’s Visible

fit tracks vertically f

scroll down (page) Page_Down

scroll down (step) downarrow

scroll up (page) Page_Up

scroll up (step) uparrow

toggle edit / mix window Alt+m Control+=

show editor mixer Shift+e

toggle zoom Shift+z
zoom (x) to selected
region(s) Control+Alt+z

zoom (x+y) to selected
region(s) Alt+z

zoom in =

zoom out -

zoom to session +

save visual state 1 Control+F1

save visual state 2 Control+F2

save visual state 3 Control+F3

save visual state 4 Control+F4

save visual state 5 Control+F5

save visual state 6 Control+F6

save visual state 7 Control+F7

save visual state 8 Control+F8

save visual state 9 Control+F9

save visual state 10 Control+F10

save visual state 11 Control+F11

save visual state 12 Control+F12

go to visual state 1 F1

go to visual state 2 F2

go to visual state 3 F3

go to visual state 4 F4

go to visual state 5 F5

go to visual state 6 F6

go to visual state 7 F7

go to visual state 8 F8

go to visual state 9 F9

go to visual state 10 F10

go to visual state 11 F11

go to visual state 12 F12
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Standard Mixbus Layout Alternate 1 Alternate 2

Window Visibility

toggle marker locations Alt+l

toggle big clock Alt+b

toggle preferences window Alt+o

toggle rhythm ferret window Alt+f

toggle metadata window Alt+d

toggle options window Alt+o

toggle export window Alt+e

toggle import window Alt+i

add new track / bus Alt+n

Standard Mixbus Layout Alternate 1 Alternate 2

Moving The Playhead
A left click in the rulers positions the playhead unless Mixbus is recording. You can use (period)>Num>(period) to
move the playhead to the n-th marker.

to start marker Home Enter Return

to end marker End

nudge backward Alt+leftarrow

nudge forward Alt+rightarrow

nudge backward to grid Control+Shift+leftarrow

nudge forward to grid Control+Shift+rightarrow

to previous region edge leftarrow

to next region edge rightarrow
to previous region edge
(ignore selection) Shift+Alt+leftarrow
to next region edge
(ignore selection) Shift+Alt+rightarrow

to previous region sync Control+Alt+leftarrow

to next region sync Control+Alt+rightarrow

to previous transient Control+leftarrow (Shift or Alt or Ctrl ) + Tab

to next transient Control+rightarrow Tab

to previous mark q

to next mark w

object mode o
range mode r
region gain mode g
timefx mode t
zoom mode z
step mouse mode 4
toggle edit mode 1

Standard Mixbus Layout Alternate 1 Alternate 2

Mouse Modes
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Standard Mixbus Layout Alternate 1 Alternate 2

Editing Features
Most edit functions operate on a single ”Edit Point”. The edit point can be defined as the playhead (default) or the
mouse. The choice of Edit Point is by default linked to the Zoom Focus.

cycle to next edit mode 1
cycle to next grid snap 2

cycle to next grid unit 3

cycle edit point 4

insert time Alt+t
cut time Shift+x

trim back k

trim front j

trim region end to edit point Shift+}
trim region start to edit
point Shift+{

set EP e

tab to transient backwards Control+leftarrow (Shift or Alt or Ctl ) + Tab

tab to transient forward Control+rightarrow Tab

Standard Mixbus Layout Alternate 1 Alternate 2
Selecting

select all Control+a

deselect all Escape
export selection Control+Alt+e

invert selection Shift+i

select all after edit point Shift+u Control+Shift+p

select all before edit point Shift+y Control+p

select all overlapping edit
range Control+|

select all inside edit range |

Standard Mixbus Layout Alternate 1 Alternate 2

Markers and Locations
The ”move” commands all move the active marker(s). Jump to the first 9 markers using the keypad digits 1-9
(requires numlock).

add marker at playhead ` (grave) NumPad Enter

remove marker at playhead Ctrl+` (grave) Ctrl+NumPad Enter

playhead to previous mark q

playhead to next mark w

go to marker 1 .(period) NumPad 1 .(period)

go to marker 2 .(period) NumPad 2 .(period)

go to marker 3 .(period) NumPad 3 .(period)

go to marker 4 .(period) NumPad 4 .(period)

go to marker 5 .(period) NumPad 5 .(period)

go to marker 6 .(period) NumPad 6 .(period)

go to marker 7 .(period) NumPad 7 .(period)

go to marker 8 .(period) NumPad 8 .(period)

go to marker 9 .(period) NumPad 9 .(period)
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Standard Mixbus Layout Alternate 1 Alternate 2

Region Operations

mute/unmute region ~

lock region !

toggle region transparency @

reverse region #

naturalize region $

transpose region %

boost region gain ^

cut region gain &

normalize region *

raise region )

lower region (

align, sync point relative a
align stack, sync point
relative Shift+a

duplicate region (once) d

duplicate region (multi) Shift+d

export selected region(s) Shift+Alt+e

insert region from list i

split / separate s b Alt+x

crop c

set region sync point v

remove region sync point Shift+v

nudge backward y NumPad -

nudge forward u NumPad +

set fade-in length /

set fade-out length \

toggle fade-in active Control+/

toggle fade-out active Control+\

Standard Mixbus Layout Alternate 1 Alternate 2

Track Operations

rec-enable selected tracks Alt+r
solo selected tracks Alt+s
mute selected tracks Alt+u
consolidate track Alt+c
toggle track active Alt+a
select next track/bus Alt+downarrow
select previous track/bus Alt+uparrow
move selected tracks down Control+downarrow

move selected tracks up Control+uparrow
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start edit range , (comma)

finish edit range . (period)

set loop start Alt+,

set loop end Alt+.
set loop range from edit
range ]
set loop range from
region(s) Alt+]

set punch start Control+,

set punch end Control+.
set punch range from edit
range [
set punch range from
region(s) Alt+[
set tempo (1 bar) from edit
range 0

Standard Mixbus Layout Alternate 1 Alternate 2

Defining Loop, Punch Range, and Tempo Changes

add control point left-click in auto track
add/remove selection Control+left-click on body
adjust region edges left-drag near ends of trim bar
copy+move region(s) Control+left-drag on body
extend selection Shift+left-click on body
fixed time adjust middle-drag on point
fixed time copy+move Control+middle-drag on body
fixed time move middle-drag on body
fixed time move Control+middle-drag on point
lower region Alt+Shift+middle on body
move control point left-drag on point
move line segment left-drag on line segment
move point+later points Control+left-drag on point
move region(s) left-drag on body
raise region Shift+middle on body
rubber-band select Control+Alt+left-drag on regions
rubber-band select left-drag on empty space
rubber-band select left-drag in auto track
select left-click on body
set region end middle in trim bar
set region start left-click in trim bar
slip audio in region Control+left-drag in trim bar

Mouse Object Mode
This mode provides many different operations on both regions and control points, partially depending on where you
click/drag with the mouse. The ”body” of a region is the area where the waveform is displayed.

Mixbus Function Mouse Command



apply to all tracks/busses Control+Shift+left-click
apply to group Control+left-click
apply to track or active group left-click
learn MIDI control Control+middle-click
momentary switch middle-click

define the new visible area left+drag

zoom in left-click

zoom out middle-click

zoom to session Control+middle
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Mouse Zoom Mode

Mixbus Function Mouse Command

Mixbus Function Mouse Command

Mouse Ops on Solo/Mute/Rec-enable

adjust left-drag
fine-drag control Control+left-drag
finest-drag control Control+Alt+left-drag
learn MIDI control Control+middle-click
reset to default Shift+left-click

exclusive solo Control+Alt+left-click
temporary latched solo Shift+left-click

Mixbus Function Mouse Command

Mouse Ops on Solo Buttons Only

Mixbus Function Mouse Command

Mouse Ops on Faders & Plug-in Controls
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Mixbus has a standard keyboard shortcut layout that provides alternate keystrokes that are available in other digital
audio workstations.  In the following tables, “NumPad” is used to reference the number pad on the right side of the
keyboard.

Standard Mixbus Layout Alternate 1 Alternate 2

Transport and Recording Control

Standard Mixbus Layout Alternate 1 Alternate 2

Session and File Handling

roll playhead spacebar NumPad 0

roll record Shift+space NumPad 3

stop and destroy Command+space

destroy last recording Command+Delete

rewind Shift+leftarrow NumPad 1

fast forward Shift+rightarrow NumPad 2

transition to reverse Shift+downarrow

transition to play Shift+uparrow

toggle auto play 5

toggle auto return 6

toggle click 7

toggle auto input 8

toggle follow playhead Command+f

toggle track rec-enable Alt+r

toggle master rec-enable Shift+r

set playhead p

play selected region(s) h

loop play (the loop range) l NumPad 4

key focus on main clock NumPad /

start a new session Command+n

open an existing session Command+o

open a recent session Command+Shift+o

save session Command+s

save session as Command+Alt+s

save session snapshot Command+Shift+s

add track(s) / bus(ses) Alt+n

import audio files Alt+i

export session Alt+e

quit Command+q

Standard Mixbus Layout Alternate 1 Alternate 2

copy Command+c
cut Command+x
delete Delete BackSpace
paste Command+v
redo Command+r Command+Shift+z Command+y
undo Command+z
quit Command+q

Common Functions
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Standard Mixbus Layout Alternate 1 Alternate 2

Changing What’s Visible

fit tracks vertically f

scroll down (page) Page_Down

scroll down (step) downarrow

scroll up (page) Page_Up

scroll up (step) uparrow

toggle edit / mix window Alt+m Command+=

show editor mixer Shift+e

toggle zoom Shift+z
zoom (x) to selected
region(s) Command+Alt+z

zoom (x+y) to selected
region(s) Alt+z

zoom in =

zoom out -

zoom to session +

save visual state 1 Command+F1

save visual state 2 Command+F2

save visual state 3 Command+F3

save visual state 4 Command+F4

save visual state 5 Command+F5

save visual state 6 Command+F6

save visual state 7 Command+F7

save visual state 8 Command+F8

save visual state 9 Command+F9

save visual state 10 Command+F10

save visual state 11 Command+F11

save visual state 12 Command+F12

go to visual state 1 F1

go to visual state 2 F2

go to visual state 3 F3

go to visual state 4 F4

go to visual state 5 F5

go to visual state 6 F6

go to visual state 7 F7

go to visual state 8 F8

go to visual state 9 F9

go to visual state 10 F10

go to visual state 11 F11

go to visual state 12 F12
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Standard Mixbus Layout Alternate 1 Alternate 2

Window Visibility

toggle marker locations Alt+l

toggle big clock Alt+b

toggle preferences window Alt+o

toggle rhythm ferret window Alt+f

toggle metadata window Alt+d

toggle options window Alt+o

toggle export window Alt+e

toggle import window Alt+i

add new track / bus Alt+n

Standard Mixbus Layout Alternate 1 Alternate 2

Moving The Playhead
A left click in the rulers positions the playhead unless Mixbus is recording. You can use (period)>Num>(period) to
move the playhead to the n-th marker.

to start marker Home Enter Return

to end marker End

nudge backward Alt+leftarrow

nudge forward Alt+rightarrow

nudge backward to grid Command+Shift+leftarrow

nudge forward to grid Command+Shift+rightarrow

to previous region edge leftarrow

to next region edge rightarrow
to previous region edge
(ignore selection) Shift+Alt+leftarrow
to next region edge
(ignore selection) Shift+Alt+rightarrow

to previous region sync Command+Alt+leftarrow

to next region sync Command+Alt+rightarrow

to previous transient Command+leftarrow (Shift or Alt or Cmd ) + Tab

to next transient Command+rightarrow Tab

to previous mark q

to next mark w

object mode o
range mode r
region gain mode g
timefx mode t
zoom mode z
step mouse mode 4
toggle edit mode 1

Standard Mixbus Layout Alternate 1 Alternate 2

Mouse Modes
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Standard Mixbus Layout Alternate 1 Alternate 2

Editing Features
Most edit functions operate on a single ”Edit Point”. The edit point can be defined as the playhead (default) or the
mouse. The choice of Edit Point is by default linked to the Zoom Focus.

cycle to next edit mode 1
cycle to next grid snap 2

cycle to next grid unit 3

cycle edit point 4

insert time Alt+t
cut time Shift+x

trim back k

trim front j

trim region end to edit point Shift+}
trim region start to edit
point Shift+{

set EP e

tab to transient backwards Command+leftarrow (Shift or Alt or Cmd ) + Tab

tab to transient forward Command+rightarrow Tab

Standard Mixbus Layout Alternate 1 Alternate 2
Selecting

select all Command+a

deselect all Escape
export selection Command+Alt+e

invert selection Shift+i

select all after edit point Shift+u Command+Shift+p

select all before edit point Shift+y Command+p

select all overlapping edit
range Command+|

select all inside edit range |

Standard Mixbus Layout Alternate 1 Alternate 2

Markers and Locations
The ”move” commands all move the active marker(s). Jump to the first 9 markers using the keypad digits 1-9
(requires numlock).

add marker at playhead ` (grave) NumPad Enter

remove marker at playhead Cmd + ` (grave) Cmd+NumPad Enter

playhead to previous mark q

playhead to next mark w

go to marker 1 .(period) NumPad 1 .(period)

go to marker 2 .(period) NumPad 2 .(period)

go to marker 3 .(period) NumPad 3 .(period)

go to marker 4 .(period) NumPad 4 .(period)

go to marker 5 .(period) NumPad 5 .(period)

go to marker 6 .(period) NumPad 6 .(period)

go to marker 7 .(period) NumPad 7 .(period)

go to marker 8 .(period) NumPad 8 .(period)

go to marker 9 .(period) NumPad 9 .(period)
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Standard Mixbus Layout Alternate 1 Alternate 2

Region Operations

mute/unmute region ~

lock region !

toggle region transparency @

reverse region #

naturalize region $

transpose region %

boost region gain ^

cut region gain &

normalize region *

raise region )

lower region (

align, sync point relative a
align stack, sync point
relative Shift+a

duplicate region (once) d

duplicate region (multi) Shift+d

export selected region(s) Shift+Alt+e

insert region from list i

split / separate s b Alt+x

crop c

set region sync point v

remove region sync point Shift+v

nudge backward y NumPad -

nudge forward u NumPad +

set fade-in length /

set fade-out length \

toggle fade-in active Command+/

toggle fade-out active Command+\

Standard Mixbus Layout Alternate 1 Alternate 2

Track Operations

rec-enable selected tracks Alt+r
solo selected tracks Alt+s
mute selected tracks Alt+u
consolidate track Alt+c
toggle track active Alt+a
select next track/bus Alt+downarrow
select previous track/bus Alt+uparrow
move selected tracks down Control+Shift+downarrow

move selected tracks up Control+Shift+uparrow
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add control point left-click in auto track
add/remove selection Command+left-click on body
adjust region edges left-drag near ends of trim bar
copy+move region(s) Command+left-drag on body
extend selection Shift+left-click on body
fixed time adjust middle-drag on point
fixed time copy+move Command+middle-drag on body
fixed time move middle-drag on body
fixed time move Command+middle-drag on point
lower region Alt+Shift+middle on body
move control point left-drag on point
move line segment left-drag on line segment
move point+later points Command+left-drag on point
move region(s) left-drag on body
raise region Shift+middle on body

rubber-band select Command+Alt+left-drag on
regions

rubber-band select left-drag on empty space
rubber-band select left-drag in auto track
select left-click on body
set region end middle in trim bar
set region start left-click in trim bar
slip audio in region Command+left-drag in trim bar

Mouse Object Mode
This mode provides many different operations on both regions and control points, partially depending on where you
click/drag with the mouse. The ”body” of a region is the area where the waveform is displayed.

Mixbus Function Mouse Command

start edit range , (comma)

finish edit range . (period)

set loop start Alt+,

set loop end Alt+.
set loop range from edit
range ]
set loop range from
region(s) Alt+]

set punch start Command+,(comma)

set punch end Command+.(period)
set punch range from edit
range [
set punch range from
region(s) Alt+[
set tempo (1 bar) from edit
range 0

Standard Mixbus Layout Alternate 1 Alternate 2

Defining Loop, Punch Range, and Tempo Changes
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apply to all tracks/busses Command+Shift+left-click
apply to group Command+left-click
apply to track or active group left-click
learn MIDI control Command+middle-click
momentary switch middle-click

define the new visible area left+drag

zoom in left-click

zoom out middle-click

zoom to session Command+middle

Mouse Zoom Mode

Mixbus Function Mouse Command

Mixbus Function Mouse Command

Mouse Ops on Solo/Mute/Rec-enable

adjust left-drag
fine-drag control Command+left-drag
finest-drag control Command+Alt+left-drag
learn MIDI control Command+middle-click
reset to default Shift+left-click

exclusive solo Command+Alt+left-click
temporary latched solo Shift+left-click

Mixbus Function Mouse Command

Mouse Ops on Solo Buttons Only

Mixbus Function Mouse Command

Mouse Ops on Faders & Plug-in Controls



All Platforms:
•   Some third-party plugins may cause crashes, strange noises, or other problems. We strive to support plug-ins as
thoroughly as possible but due to the many variables (Computer platform, OS version, Mixbus version, plug-in ver-
sion, etc) it is not possible to guarantee that all 3rd-party plug-ins will work as expected on your system.
•   Pressing “Tab” when editing a track name will advance to the next track so you can name it.  However this will
simultaneously do a “Tab to Transient”.  This is annoying but non-destructive.
•  On systems with the minimum supported screen height (800 pixels), you may have significant problems with track
sizing, drawing, and even lockups or other serious issues with the editor.  2 workarounds exist:  Do not show the
“Editor Mixer”  (shift-e by default).  Or ( minimize / auto-hide / move to the side) your desktop’s Taskbar/Dock/launch
bar to maximize screen height.
•  Master bus "lookahead" latency is not compensated.  It should be disabled when recording or bouncing tracks. 

Windows-specific issues:

•  Mouse disappears on some VST plugin windows.  Clicking the mouse button normally displays it

OSX-specific issues:

•  Mixbus reports a generic "can't load session" message instead of the more explicit "out of ports" mes-
sage that appears on Linux. If you get the "can't load session" dialog, check the Audio Setup tab, under
Options/Number of Ports, verify that the number is higher than 128 (512 is a good number).

Linux-specific issues:

•  On some systems with proprietary opengl drivers (ATI and NVIDIA),  some users have reported extremely slow
drawing speed.  A workaround is to set the environment variable  “FORCE_BUGGY_GRADIENTS”, which will tell
Mixbus to draw color gradients in software rather than hardware-accelerated.  For more details, contact Harrison via
email ( mixbus@harrisonconsoles.com).
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Mixbus 2.5

New Features (all platforms): 

•  3 new Pre-installed XTools for Mixbus: XT-EG Expander/Gate, XT-DS De-Esser, and XT-VC Vocal Character.  To
use these plugins, you must purchase a license at http://mixbus.harrisonconsoles.com

Improvements & Fixes (all platforms): 

•  Some limitations of VST plugins have been lifted.  Plugins with more than 1/1 I/O can now be used in mono chan-
nelstrips.  Plugins with more than 2/2 I/O  can now be used in stereo channelstrips.
•  Dither selector menu was disabled for 24-bit exports. This has been fixed
•  Side-scrolling is now ignored for channelstrip knobs and faders. This should make it easier for magic-mouse users
to side-scroll the mixer window.
•  Sessions are no longer saved with every new track;  instead Mixbus waits until all tracks are created before saving
the session.  This alleviates some problems when running from a networked drive.

Plugin-specific changes:

•  The low band shelf/bell selector on the Bass Character plugin was controlling the high band as well. This has been
fixed 
•  Fast moves on the XT-EQ and XT_ME will not "skip" some of the control bands ( OSX only; windows and linux did
not have this issue )
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Mixbus 2.4

New Features (all platforms): 

•  Pre-installed XTools for Mixbus: XT-BC Bass Character plug-in.  To use these plugins, you must purchase a
license at http://mixbus.harrisonconsoles.com

Improvements & Fixes (all platforms): 

•  Added new alternate keybindings to the keymap.  Alt+x to split (Cubasish) and Cmd (Control) += to switch between
the mix / edit windows (ProToolish).
•  Added links to our YouTube tutorials and User Forum in the Help Menu.
•  Ranges now disappear after deleting a range in ripple mode.
•  Removed the Master item from the master bus output.
•  Removed EditAtMarker selection, removed Splice editing.
•  Renamed Tape Mode to Destructive
•  Ripple Edit now functions on automation tracks.
•  3D Triple Delay now works with buffer sizes smaller than 256 samples
•  Fixed intermittent bug causing the 3D Triple Delay to go silent.
•  Exporting ranges to multiple wave files: processing now “stops” between exports so latency compensation can get
set.
•  Fixed crash bug from locating on the timeline with a plug-in parameter in write to an area without automation data.
•  Fixed “cannot save” message caused by too many open files.  This most often affected OSX users with lots of AU
plug-in presets, but the general fix applies to all platforms and users.
•  Fixed bug in gain or plug-in automation that would cause points to swap, causing a shape that was drawn as a
“square wave” to go “sawtoothed.”

Windows-specific changes:

•  It is no longer necessary to uninstall the program when updating.

OSX-specific changes:

•  Interpolated mouse moves so fast moves don’t get missed by the Harrison EQ plug-ins.
•  Harrison plug-ins use about 50% of the processing power compared to the previous version

Linux-specific changes:

•  Harrison plug-ins use about 50% of the processing power compared to the previous version
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Mixbus 2.3

New Features (all platforms): 

•  Pre-installed Xtools for Mixbus: XT-ME Mastering Equalizer, XT-MC Multi-band Compressor, XT-EQ Equalizer.  To
use these plugins, you must purchase a license at http://mixbus.harrisonconsoles.com
•  New features for “Essentials” plugins:  GVerb+ now has input high-pass filter, and adjustable predelay up to
150ms.  3D Delay now has a tap-tempo button, and a selectable oversampling value to balance modulation quality
vs CPU load. 
•  Major bussing workflow improvements:  Hover over a track’s bus assignment buttons to see the list of new fea-
tures. ( see video attached to the update email )
•  Major editing workflow improvements:  The “implicit range” no longer exists.  Instead, the user may use the
,(comma) and .(period) buttons to set the start and end points of the edit range.  This, combined with a complete
overhaul of keybindings, provides an editing workflow that will be very comfortable to users of other audio and video
editors.

Improvements & Fixes (all platforms): 

•  Refined keymap.  Keymap is no longer able to be edited by users, but it now incorporates “alternative” bindings for
major functions so that users of other popular DAWs will have their keys available at the same time as the existing
Mixbus functions.
•  Alt+m toggles edit window and mix window more reliably, and handles multi-monitor setups better.
•  Master tape saturation can now go down to -40dB.
•  Holding Alt while adjusting a fader with the mousewheel will now override the group.
•  Importing audio defaults to highest quality SRC.
•  Backup files now have their own directory in the session folder.
•  Separate and split now share the same key command.
•  Transparent regions were double-summing the underlying region during crossfade.  This has been fixed.
•  Selecting a plugin preset will now mark the session as “dirty” so it will prompt the user to save when quitting.  This
will solve some problems where plugins did not seem to remember their settings. 

Windows-specific changes:

•  Better support for non-power-of-2 ASIO buffer sizes. This will fix many strange issues with ASIO drivers.
•  Fixed a bug when recalling older VST plug-ins that expect the host to terminate the parameter names after 8 char-
acters.
•  Fixed crashes when editing fades after an undo.

OSX-specific changes:

•  Fixed key command for moving tracks up and down in the editor, and moved several key commands so that they
are no longer “hidden” by OSX key commands.

Linux-specific changes:

•  Gtk updated to support CALF LV2 plugins
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Mixbus 2.2

New Features (all platforms): 

•  Pre-installed “Essentials” plugin Pack.  To use these plugins, customers must purchase the Essentials license
at:  http://mixbus.harrisonconsoles.com
•  Cut Time:  deletes a portion of the session timeline, optionally including markers, tempo and meter changes.
•  “Color Tracks Together” allows user to quickly select tracks and make them share a color.

Improvements & Fixes (all platforms): 

•  Region gain is now stepped in 1dB increments and allows unlimited gain/attenuation.
•  Drag/Drop region inserts and pasting of regions will now ripple when in Ripple Edit mode.
•  Region trims no longer “ripple” their changes when in Ripple Edit.
•  A secondary keybinding for “Add Marker at Playhead” was added to accomodate keyboards without number pads.
This action is bound to “m” in the mnemonic-us and default-us keymaps.
•  Select All (ctrl/cmd-A) now selects all regions AND tracks.
•  The display of the range selection has become very slow in 2.1.  This has been fixed.
•  Scroling has become very slow with multiple automation tracks, even when they are hidden.  Scrolling speed will
now be unaffected if the automation tracks are hidden.
•  Picking a color for a track would sometimes not immediately update the regions in the track. This has been fixed.
•  Solo Clear now clears mixbus solos as well as tracks.
•  Knob sensitivity has been increased in some cases.
•  LV2 plugins now allow multi-mono instantiation, so you can put a mono LV2 plugin in a stereo track (it will operate
in dual-mono).
•  Recording grouped fader automation now works in Touch as well as Write.
•  The dialog for “Export Region” was showing the track source selector. This has been fixed.
•  Potentially fixed an intermittent crash that occurred during heavy fader automation.

Windows-specific changes:

•  Clicking on the timebar ruler to locate the playhead while playing might cause an offset of 1-2 buffer periods
between tracks.  This has been fixed.
•  If multiple monitors were used in the past, the Mixer & Edit windows have their position stored in that location
which would make them unavailable when only one monitor is connected. This has been fixed.

OSX-specific changes:

•  KP_Enter  ( Enter on the number pad )  was the default key to create a new marker.  However this key was
unmappable in previous versions of Mixbus on OSX.  This has been fixed, so now  KP_Enter will create a new mark-
er at the playhead as intended.

Linux-specific changes:

•  MFixed several bugs in MIDI controller operation and save/recall.
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Mixbus 2.1

New Features (all platforms): 

•  Freesound import.
•  Soundcloud export.
•  Metadata editor.
•  Hold “Alt” to override mix-groups for fader/mute.
•  Reworked region fades and crossfade shapes, including re-adding the constant-power crossfade and setting it to
default when a crossfade is created with Automatic Crossfades engaged.
•  Mixbus can utilize the (optional 3rd-party) ArdourXchange plugin to load AAF and OMF session files.

Improvements & Fixes (all platforms): 

•  File “tags” are now correctly saved and recalled.
•  LADSPA and VST plugin user presets are now saved/recalled.
•  Session is now marked “dirty” when a plugin GUI is manipulated. This should fix some reports of plugins that don’t
save/recall their state.
•  Automation and gain lines are now thicker and easier to see when editing.
•  When no track is selected in the editor, the Master bus will be shown on the left.
•  Removed “advanced options” from the New Session dialog.
•  Consolidate and Bounce functions “with processing” are removed to avoid confusion; these can’t work in Mixbus.
•  Fixed keybindings for setting region fade in/out length.
•  Changed fader scale so mouse stays within mixer window.
•  Re-added meter to import window auditioner.
•  Automation thinning was much too aggressive on low-level fader moves. This has been fixed.
•  Improved export dialog is much easier for new users to set up.
•  Fixed crash caused by 2 tracks with fader automation in a mix group.
•  Faders move in realtime when playing back automation (fixes a bug introduced in 2.0.7)
•  Post-fader plugin output is no no longer muted when the fader is set at -inf.
•  Fixed a bug that caused crashes when opening sessions with plugin sliders attached to nonexistent plugins.
•  Fixed an automation editing bug that caused “sawtooth” automation to be created unexpectedly.
•  Fix crash when user releases a touched control after transport is stopped.
•  Several other fixes to realtime automation and graphical automation editing.

Windows-specific changes:

•  VSTplugins are now sent correct transport position and state (fixes plugins with transport )
•  Improved CPU performance with VST plugins.
•  Shell ( Waves ) plugins can now be loaded without using shell2vst.
•  Canceling an “export” will no longer cause the transport to become unresponsive.

OSX-specific changes:

•  Fix for AU plugin window locations: when hidden, plugin windows are now more likely to re-appear where you last
had them.
•  On systems with a specific monitor setup, the plugin window and container would be separated onto 2 different
monitors.  This has been fixed.
•  Some versions of Apple AU plugins would not allow mouse to control parameters.  This is fixed.
•  Fix for AU plugins that “lost” the right channel output, among other issues.
•  Removed dependence on X11 libs which caused a failure to launch on systems that were mysteriously missing
these system libs.

Linux-specific changes:

•  Mixbus will now look in usr/lib64 for LV2 plugins on a 64bit system.
•  LV2 plugin windows will no longer disappear when tracks are selected & deselected.
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Mixbus 2.0.7

Changes (all platforms): 
•  Added plugin latency to click ( metronome ) so it stays aligned during recording/playback when plugins with
long delays are added to one or more mixbuses.  
•  When choosing Play->Loop Range from the region context menu, the loop markers would not appear.  This
has been fixed.  
•  Ctrl+Shift click on track Mutes and Solos are no longer applied to Mixbus and Master buses.  
•  Improved logic to determine which menu items should be available when using the Mouse as edit point.
•  Removed submenu items from the keybindings editor.  
•  French version can now export 16bit files.  
•  Edit->Separate was not enabled if the user selected a Range using the range or smart tools. This has been
fixed.
•  Removed “!” from licensing message if license is found.  
• “Crop” function no longer applies to ALL tracks if no tracks are selected.  

Windows-specific changes:
•  Various VST plugin crash fixes.
•  VST scan paths are now obeyed more correctly.
•  After scanning VSTs, the plugins would not appear in the plugin manager until after a restart.  This has been
fixed.
•  The “scan” button now saves the new VST paths before scanning them, so that if a plugin crashes the scan,
the paths are remembered on the next launch.
•  Fixed an intermittent hang at “starting audio engine”.
•  Many more fixes for non-English installations.
•  When a control is grabbed inside the window, releasing the mouse button would not release control of the
knob until the window was re-entered and clicked on.  This has been fixed.
•  Changed fader scaling so mouse doesn’t need to exit window to get full-scale travel of the fader.

OSX-specific changes:
•  Compressor, EQ, Mixbus, and Phase buttons are now controllable via MIDI.  
•  Fix long-standing bug that causes context menus to sometimes remain unclickable until you have exited the
menu and re-entered the menu.
•  F-keys did not respond in v2.0.6., so view saving/recall was impossible. This has been fixed.
•  Binding to move tracks up/down did not work in 2.0.6. This has been fixed.
•  Switched to latest Gtk graphics stack.  This improves performance and solves some subtle bugs.
•  Removed submenu items from the keybindings editor.  

Linux-specific changes:
•  Compressor, EQ, Mixbus, and Phase buttons are now controllable via MIDI.  
•  Fixed crash when deleting LinuxDSP LV2 plugins.
•  Fixed crash in “Undo” feature and “Phones Verb” preset in Gverb+ plugin.
•  Removed submenu items from the keybindings editor.

KNOWN ISSUES:
•   Some third-party plugins may cause crashes, strange noises, or other problems. We strive to sup-
port plug-ins as thoroughly as possible but due to the many variables (Computer platform, OS version, Mixbus
version, plug-in version, etc) it is not possible to guarantee that all 3rd-party plug-ins will work as expected on
your system.
•  VST plugins must match the I/O of the track they are used on.  Mono tracks require a mono VST plugin, and
stereo requires a stereo VST plugin.  Many VST plugins only come in stereo variants.  As a workaround, you can
create a stereo track for your mono audio regions (files) and use stereo VST plugins on these tracks. ( Windows
only )
•  Mouse disappears on some VST plugin windows.  Clicking the mouse button normally displays it ( Windows
only)
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•  VST Shell  ( Waves ) plugins do not load.  Some users find that the third-party application shell2vst.exe is a
workaround. ( Windows only )  A beta version with Waves Shell support is available for those who wish to test
this functionality.
•  On systems with the minimum supported screen height (800 pixels), you may have significant problems with
track sizing, drawing, and even lockups or other serious issues with the editor.  2 workarounds exist:  Do not
show the “Editor Mixer”  (shift-e by default).  Or minimize the size (or auto-hide) your desktop’s
Taskbar/Dock/launch bar to maximize screen height.  
•  Ripple Edit does not work on automation.
•  Master bus "lookahead" latency is not compensated.  It should be disabled when recording or bouncing tracks. 

Mixbus 2.0.6

Changes (all platforms): 
•  Improved layout of the plugin selector dialog.  Allows user to double-click plugins to remove them.  
•  Views may now be saved with ctrl+Fn keys, and recalled with the Fn key.  
•  Added 176.4kHz sampling rate.
•  Fixed crash on session load caused by plugin fx sliders.  
•  Fixed problem with Russian sample-rate translation that kept Audio Engine from starting on systems using
Russian language.

Linux-specific changes:
•  Fixed crash when deleting Invada LV2 plugins.

OSX-specific changes:
•  Includes JACK 0.89 which provides support for ProTools software and improves support for older Protools
hardware such as MBox and other devices.  ( ProTools and MBox are trademarks of Avid Technology, Inc).

Windows-specific changes:
•  Added a full-featured VST plugin path manager in Windows->Preferences->Plugins.
•  Added missing bindings files  ( “Cubasish” and “ProToolish” )
•  Dramatically improved file “import” speed.
•  Several improvements to VST plugin loading, caching, and cache management.  VST plugins which cause a
crash during scanning are now kept in a blacklist and will not be scanned after the first failure.
•  Some VSTs would freeze the Mixbus editor GUI while knobs were held. This has been fixed.
•  When scanning VST folders, a dialog apears to show each plugin as it is scanned.
•  Many VST plugins ( particularly those based on the JUCE library) were unable to show their window. This has
been fixed.
•  VST plugin windows were forced on top, which would sometimes obscure a dialog.
•  Directsound audio devices are now more easily selectable, and separate input/output selections are easier.
•  On 64bit systems, a 64/32-bit “mixed mode” JACK is now installed (finds more audio drivers that previously
required ASIO4ALL)
•  When an ASIO device is selected, the device’s preferred buffersize is automatically selected.
•  Systems with Windows installed on a drive other than C:\  should now work.
•  Systems with file-paths using non-latin characters should now work.
•  Fixed display of High EQ band on channel strips when they are in “narrow” mode.

KNOWN ISSUES:
•   Some third-party plugins may cause crashes, strange noises, or other problems. We strive to sup-
port plug-ins as thoroughly as possible but due to the many variables (Computer platform, OS version, Mixbus
version, plug-in version, etc) it is not possible to guarantee that all 3rd-party plug-ins will work as expected on
your system.
•  VST plugins must match the I/O of the track they are used on.  Mono tracks require a mono VST plugin, and
stereo requires a stereo VST plugin.  Many VST plugins only come in stereo variants.  As a workaround, you can
create a stereo track for your mono audio regions (files) and use stereo VST plugins on these tracks. ( Windows
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only )
•  Mouse disappears on some VST plugin windows.  Clicking the mouse button normally displays it ( Windows
only)
•  VST Shell  ( Waves ) plugins do not load.  Some users find that the third-party application shell2vst.exe is a
workaround. ( Windows only )
•  On systems with the minimum supported screen height (800 pixels), you may have significant problems with
track sizing, drawing, and even lockups or other serious issues with the editor.  2 workarounds exist:  Do not
show the “Editor Mixer”  (shift-e by default).  Or minimize the size (or auto-hide) your desktop’s
Taskbar/Dock/launch bar to maximize screen height.  
•  Ripple Edit does not work on automation.
•  Master bus "lookahead" latency is not compensated.  It should be disabled when recording or bouncing tracks. 

Mixbus 2.0.5

NEW FEATURES:
None

FIXES:
•  Fixed several long-standing bugs that caused crashes when closing a session or switching snapshots on some
systems.
•  Range-based editing actions were not using the explicitly-defined range when in Smart mode.  This fixes prob-
lems with "set tempo/loop/punch from edit range" as well as other related issues.
•  Fixed a crash in "plugin sliders" that sometimes caused session files to be unloadable.
•  When recording a track and high-latency plugins are used, the recorded audio would be placed at the wrong
location on the timeline.  This has been fixed.
•  Items in the Regions menu were only available if there were keybindings assigned to the menu action.  This
has been fixed.
•  The knobs on the "editor mixer" strip would sometimes show the automation of another channel's knobs when
the strip is switched between channels.  This has been fixed.
•  It is now possible to delete a range of automation when in Object mode, not just Smart mode.
•  Reinstated the "mouse edit point" cursor, so Mixbus changes the cursor when it is over a region to show that
the current edit point is set to Mouse
•  Cleanup will now ignore snapshots that were generated by the auto-backup.  The auto-backup files were pre-
venting the cleanup from deleting audio that is not used in any user-stored snapshots.
•  Fixed an error in the region-gain-line-drag functionality that caused a problem with undo, redo and save/recall.
•  The last point in the gain change would not be recalled correctly, causing a "ramp" to the following point.  This
has been fixed.
•  When in "narrow" mode, the channel EQs would not automatically engage the EQ.  This has been fixed.
•  The online search for "announcements" could cause a long startup delay if the user's network is enabled but
no DNS server is available.  This has been fixed.
•  "International" characters in session names became "__" (double underscores) and sometimes prevented
Mixbus from finding audio files inside the session.  This has been fixed.
•  Some button selections in the Export dialog would fail when an alternate language is selected.  This has been
fixed.
•  Region dragging while in "Ripple" mode were not undo-able.  This has been fixed. 

OSX - SPECIFIC FIXES:
•  Ripple edit doesn't work with range "Delete", you have to use "Cut".  This has been fixed (only affected OSX
Intel).
•  Mixbus on OSX can now load LV2 plugins (for testing purposes only).

LINUX - SPECIFIC FIXES:
•  Fixed installer to work with non-English words for "Desktop".  Also improves support for systems without sup-
port for sudo.
•  Added ability to disable hardware-accelerated gradients, which causes problems with some proprietary video
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card drivers.
•  LV2 plugins should recall the port "symbols"  (such as "wet_dry_mix")  instead of the port index.  This improves
support of old plugins that have added or removed controls from the previous version.

IMPROVEMENTS:
•  Flush Wastebasket is now available without having to re-open the session.

KNOWN ISSUES:
•  On Mac OSX Intel, Mixbus crashes if you try to enter a metadata "Tag" on a file in the Import dialog.
•  On systems with 2 monitors the primary monitor (the one with the OSX menu) must be on the left or some
plug-in windows will display outside of their enclosing windows.
•  Some third-party AudioUnit plug-ins may cause crashes, strange noises, or other problems. We strive to sup-
port plug-ins as thoroughly as possible but due to the many variables (Computer platform, OS version, Mixbus
version, plug-in version, etc) it is not possible to guarantee that all 3rd-party plug-ins will work as expected on
your system.
•  Mixbus on OSX reports a generic "can't load session" message instead of the more explicit "out of ports" mes-
sage that appears on Linux. If you get the "can't load session" dialog, check the Audio Setup tab, under
•  Options/Number of Ports, verify that the number is higher than 128 (512 is a good number).
•  Ripple Edit does not work on automation

•  Master bus "lookahead" latency is not compensated.  It should be disabled when recording or bouncing tracks. 

Mixbus 2.0.4

NEW FEATURES:
None

FIXES:
•  K14 meter display was incorrect in v2; it is now fixed.
•  MIDI bindings to Mixbus knobs are now saved/recalled with the session.
•  Disabled region fade-ins would be re-enabled on session load.  This has been fixed.
•  Mixbus strips will now remember their visible "width" when a session is saved and recalled.
•  When clicking to adjust a fade length, the user had to be careful not to click on the fade in/out lines which
would cause the fade grab to be ignored.  This has been fixed.
•  Import of filenames with certain characters (such as ö) in the filename or file path would fail.  The file could be
auditioned before importing, but the import to Mixbus would fail.  This has been fixed.

IMPROVEMENTS:
•  Mac OSX 10.7 (Lion) is now supported
•  When Mixbus strips are narrowed, show the name instead of mixbus #.
•  Delete was implemented as a "cut" operation, which replaced any contents in the Paste buffer.  This has been
changed so that Delete does not modify what is in the Paste buffer.
•  When clicking to add a gain point, hold Cmd/Ctrl  to add the new point on the existing line
•  Mixbus automatically creates multiple backup files automatically.  A maximum of one session file per hour is
stored.  This operates in addition to the existing "backup" file.
•  Selecting a region in the editor will now highlight it in the region list.

KNOWN ISSUES:
•  Sometimes closing a session will cause a crash.  This affects operations like "Open" and "Recent" and snap-
shot-switching when a session is already open.  This has been fixed in Ardour3 but will not appear in Mixbus
until we adopt the Ardour3 platform.  In the interim, we suggest that you always "Quit" Mixbus before opening a
new session or snapshot.
•  On Mac OSX Intel, Mixbus crashes if you try to enter a metadata "Tag" on a file in the Import dialog.
•  On systems with 2 monitors the primary monitor (the one with the OSX menu) must be on the left or some
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plug-in windows will display outside of their enclosing windows.
•  Some third-party AudioUnit plug-ins may cause crashes, strange noises, or other problems. We strive to sup-
port plug-ins as thoroughly as possible but due to the many variables (Computer platform, OS version, Mixbus
version, plug-in version, etc) it is not possible to guarantee that all 3rd-party plug-ins will work as expected on
your system.
•  Mixbus on OSX reports a generic "can't load session" message instead of the more explicit "out of ports" mes-
sage that appears on Linux.   If you get the "can't load session" dialog,  check the Audio Setup tab, under
Options/Number of Ports, verify that the number is higher than 128  (512 is a good number).
•  Time alignment when recording is not always correct, especially when there are plugins with latency on the
mixbuses. When recording, plugins with long latency should be avoided on the mixbuses until we resolve this
problem.
•  Ripple Edit does not work on automation

Mixbus 2.0.3

NEW FEATURES:
None

FIXES:
•  Fixed timestamp locations when importing multiple BWAVs.
•  Fixed timestamp location when importing files that are sample-rate converted.
•  Screen size was being detected wrong in vertically-stacked monitors, or when using different-sized monitors.
Now the graphical elements will be sized based on the smallest monitor in your setup. 

IMPROVEMENTS:
•  Crossfades:Overlap has been changed to "Automatic" mode (in name only, the operation is still the same).
Options:Crossfades:Short has been replaced by Options:Crossfade:Manual.  See description of new operation in
Section 26.0 - Mixbus Options.
•  Toggle-able Plugin parameters (i.e. boolean switches) now show more clearly that they are switches and not
sliders. 

Mixbus 2.0.2

NEW FEATURES:
None

FIXES:
•  Fixed a crash caused by the new "plug-in slider" controls on some AU plug-ins.

IMPROVEMENTS:
•  Added  SMPTE timecode mode selectors to the View menu.

KNOWN ISSUES:
•  Sometimes opening a new session snapshot without first restarting Mixbus will cause a crash.  This has been
fixed in Ardour3 but will not appear in Mixbus until we adopt the Ardour3 platform.
•  On Mac OSX Snow Leopard Mixbus crashes if you try to enter a metadata "Tag" on a file in the Import dialog.
•  On systems with 2 monitors the primary monitor (the one with the OSX menu) must be on the left or some
plug-in windows will display outside of their enclosing windows. 
•  Some third-party AudioUnit plug-ins may cause crashes, strange noises, or other problems.  We strive to sup-
port plug-ins as thoroughly as possible but due to the many variables (platform, OS version, cpu type, Mixbus
version, plug-in version, etc)  it is not possible to guarantee that all 3rd-party plug-ins will work as expected on
your system.
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Mixbus 2.0.1

NEW FEATURES:
None

FIXES:
•  PPC OSX 10.4.11  systems would not load the Harrison channel DSP plug-in.  This has been fixed. 
•  Linux distributions with libcrypto1.0 would not load the Harrison plug-in.  This has been fixed. 
•  Rhythm Ferret, tab-to-transient, and Reverse functions did not work.  These have been re-enabled.
•  Crash in JACK->Reconnect with older versions of JACK have been fixed. 
•  Mixbuses 5-8 did not recall properly.  This has been fixed. 
•  Rubberband-select of regions was deselecting existing selection.  This has been fixed. 

IMPROVEMENTS:
•  Changed app name to Mixbus2 so it can coexist with existing Mixbus installation.

Mixbus 2.0

NEW FEATURES:
•  8 Mix Bus Sends from every track.
•  Plug-in Effect Control Sliders allow you to map plug-in controls directly to controls on the mixer strip.
•  Improved Mixer navigation and display, including narrow mixer strip and the ability to show/hide Mix Buses as
needed.
•  Brought controls to the mixer screen that were previously available in popup dialogs.
•  "Smart Object" Mode:  Allows a combination of object and range mode.  (see Quickstart guide)
•  Ripple Edit Mode allows faster editing of song sections and spoken-word recordings.
•  New Correlation (phase) meter on the Master Bus displays mono compatibility of the stereo mix.

FIXES:
•  Record delay compensation:  sometimes recordings were not aligned correctly with existing material.  This has
been fixed.
•  Many operational and crash fixes for automation.
•  Many operational fixes to editing, covered above and in the Quick Start Manual.
•  TimeFX (stretch) would sometimes fail to update the region's displayed length.  This has been fixed.
•  Refinements to the mix engine providing less CPU usage, and more resistance to plug-ins that generate
denormals or NANs.
•  Renaming a Marker will now mark the session as “dirty” and allow saving.

IMPROVEMENTS:
•  Polarity (phase) buttons on the top of every mixer strip.
•  Plug-ins, sends, inserts and the fader now appear in a single redirect box at the top of the mixer strip.  This
allows easier signal reordering and allows more space for Mixbus controls.
•  Some controls that were hidden in popup display are now shown on mixer.  Master Limiter controls are now
shown on the Master Strip.  Input trim and makeup gain are now shown on tracks trips.  The sidechain enable
and master bus assign are now shown on Mix Bus strips.
•  LADSPA plug-ins with invalid I/O for the current track will be disabled in the "Favorites" menu, and will display
"invalid I/O" on the plug-in manager.  So you don't get the "invalid plug-in" window.
•  Add selected-track mute/solo bindings.
•  Taller, higher-contrast faders on the mixer strips.
•  For Macbooks, the Backspace (labeled "Delete" on macbooks) now operates like the regular Delete key.
Users of Mixbus 1.5.1 or before must enable this feature by binding the button to Delete (Backspace).  You can
also click Preferences->Keybd/Mouse->Keyboard Layout and choose one of the available bindings.  The system
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default is "mnemonic-us", which implements all of these new features. (Note:  this will overwrite any custom key-
bindings you have done).
•  Many user-suggested tweaks to menus which move the most-used functions to the top areas of the menu.
•  Regions are transparent when moving, but switch to opaque when you drop them in place. Range-selection
behavior now allows you to drag down across multiple tracks at once - while also supporting edit groups.
•  Recording automation in realtime is much more stable; and allows recording automation in a loop.  it also thins
the data when recorded so it is easier to edit.  Editing automation is more Range-y.  Mouse-wheel does latch.
You can now grab a range of time and drag all the control points without having to click on the "line".
•  Edit and Mix groups now default to "active" when they are created
•  Refined operation of join_play_range.  Region trims and fades should locate the playhead for auditioning if
join_play_range is engaged.  Preroll time is configurable in Preferences->Misc.
•  Refined editing of crossfades.  See Region Editing, in the User Manual.
•  Significant fixes to realtime touch/write automation.  First switch to Touch now uses the current value, rather
than changing to the default value; automation "punch-ins" now work correctly, and allow recording automation in
a loop.  Automation only records in forward motion and is added more checks to make sure automation lists are
maintained in correct order.  The mouse wheel will now trigger touch, and works like "latch".  (see Automation in
the User Manual)
•  Rationalize Gain mode and Automation editing:  Gain curves are only highlighted on region entry when using
MouseGain.  Gain and automation selections now act more Range-y, with more consistency between them, and
don't use rubberbanding.  Gain mode works on automation tracks as well as regions.  First gain-click in a region
will show the gain curve, if it is hidden, instead of adding a new point. Automation now allows tweaking like Gain
curves.  In the past it was possible to accidentally mix region and CP selection in a rubberband select, this is
now disallowed.
•  When dragging a range, you can now sweep the range to adjacent tracks above or below the selected track.
•  Mix and Edit Groups now default to "Active" when created.
•  Clicking on a Range Marker will set the Selection Range to the range.
•  Various tweaks to zooming and zoom code.  When holding playhead, allow vertical movement of mouse to
change zoom scale (linux only).
•  Some unimplemented/confusing buttons on the Rhythm Ferret and Spectrum Display have been removed.
•  Change automation line color to white so they are more visible against the region background.  Change back-
ground colors of some buttons, and limit Mixbus to use the dark theme for now.

KNOWN ISSUES:
•  Sometimes opening a new session snapshot without first restarting Mixbus will cause a crash.  This has been
fixed in Ardour3 but will not appear in Mixbus until we adopt the Ardour3 platform.
•  On Mac OSX Snow Leopard, Mixbus crashes if you try to enter a metadata "Tag" on a file in the Import dialog.

Mixbus 1.5.1 (8858)

FIXES
•  Fixes a bug revealed by sessions created by the 3rd-party AATranslator application.
•  Fixes a bug which removed the outputs for "Sends" and the Click (metronome).  This bug was introduced in
v1.5.
•  Fixes the key shortcut to the "Separate" function in the default keybindings.
•  Fixes a bug that causes a crash in Tom Szilagyi's IR LV2 plug-in when an impulse response is loaded.  (Linux
version only) 

Mixbus 1.5 (8812) (INITIAL RELEASE ON LINUX)

FIXES
•  Fixed bug with automation editing associated with zooming in & out while editing.
•  Fixed bug where end marker moves to the end of last recorded region whenever you change the end trim of
any region
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NEW FEATURES
•  New Region-Gain-Range editing mode (see page 20, above)
•  New “Join Playhead to Edit Range” transport/editing mode
•  New key-mappable “play with pre-roll” in Transport menu

IMPROVEMENTS
•  Channel compressor controls are tweaked for easier setup with drums & percussion
•  Dynamic automation is now “thinned” during recording.  Thinning strength is configurable via ardour.rc file.

KNOWN ISSUES (All platforms)
•  Occasional crash when changing sessions/snapshots without a restart in-between.

KNOWN ISSUES (OSX)
•  OSX, there is no AU plug-in "validation". Some plug-ins cause crashes, strange noises, or silence. However as
of 1.4.1, we are not aware of problems with any commercially-available plug-ins. 
•  Stereo-only AU plug-ins may not be loaded into mono channel strips.
•  Some users have problems with plug-in windows: the window frame and the contents of the plug-in display are
separated.  This occurs if your monitor layout uses the "main" monitor (the one with the OSX menu at the top) to
the right of the secondary monitor.  To fix the problem, change your Monitor Layout so that the main monitor is
on the left. 

Mixbus 1.4.1 (7948)

FIXES
•  v1.4 would crash whenever a snapshot was loaded while Mixbus was running.  This is fixed.

IMPROVEMENTS
•  “Protoolish” and “Cubasish” keymap files are now included.
•  When tracks are made very small, the Rec/Mute/Solo buttons now remain visible.

Mixbus 1.4 (7900)

NEW FEATURES
•  New “protoolish” and “cubasish” keybindings options make the key commands similar to popular workstations.
These are initial versions and will be expanded in the future.
•  Mixbus now checks for updates via the internet and alerts the user when there is news.

FIXES
•  In 1.3, menus would sometimes not get “attention” when they were first opened.  The mouse would have to be
moved off the menu, then back onto it.  This has been fixed.
•  Solo-ing a mixbus now works as expected... the “main” assign from channels to the master will not be heard
when a mixbus is soloed.
•  PPC versions were missing a lot of text in the edit window (including region names).  This has been fixed.
•  The “moving mixer strips” bug (introduced in v1.3) is resolved.
•  Mono regions in a stereo track will now play on both sides of the stereo track. (this was listed as a fix in v1.3
but not implemented).

IMPROVEMENTS
•  Mixbus and Master buses are now handled and ordered separately from the tracks and buses in the “Edit” win-
dow.  This more accurately matches the layout in the Mix window.
•  “Spacebar” and “Numpad Enter” are now handled correctly in the keybindings window.
•  Removed a few features from the Region List such as “remove” and “hide” which had confusing implementa-
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tions.
•  Minor change to the popup window editor so that the compressor “mode” is a menu selection instead of a slid-
er.

KNOWN ISSUES
•  Sessions opened in 1.3, then re-opened in 1.2 may display the Mix buses in the wrong order.  Sound will be
correct, though.
•  Some users have problems with plug-in windows: the window frame and the contents of the plug-in display are 
separated.  This problem can be alleviated by changing the monitor arrangement.  If you have this problem,
please contact us at http://mixbus.harrisonconsoles.com
•  Many plug-ins, including some versions of Celemony's “Melodyne Bridge” will cause Mixbus to crash at start-
up.  If you have problems crashing at startup, please copy/paste the text of the “crash report” to Harrison at:
http://mixbus.harrisonconsoles.com.  Currently, the only solution is to remove these plug-ins from your AU com-
ponents folder. 
•  Some users have reported problems with 1.3 using UAD plug-ins.  We have tested at the factory on a
G5+UAD1 PCI system, as well as an Intel UAD2 Solo system, and it works for us.  Please contact us if you have
problems.

Mixbus 1.3 (7541)

NEW FEATURES
•  Mixbus and Master tracks may now appear in the editor so their automation can be edited. 
•  "Stationary Playhead" transport mode (experimental). 

FIXES
•  Popup menus and windows are now multi-monitor aware. 
•  Lists of files & folders will no longer display glitches when scrolling. 
•  When soloing a track, the Sends from other tracks are now muted. 
•  Intermittent crash when right-clicking to choose a fade shape has been fixed. 
•  Fixed a bug that inhibited playback, which was often encountered after an "export".
•  Region export & bounce should now apply gain & fades correctly. 
•  Fixed a bug where regions in heavily-edited tracks occasionally don't play back. 
•  Solo: when a track is in solo mode and then removed - all other tracks will no longer stay in 'mute'. 
•  AIFF export will no longer allow some formats that were unrecognized by popular audio apps. 
•  Weird punch behavior where non-rec-enabled tracks end up with regions has been fixed. 
•  Occasional problem which caused 100% CPU usage after killing JACK has been fixed. 
•  Stopped GTK shutdown from causing a crash in some cases. 
•  Clocks no longer cease updating when reverse playback is used. 
•  Keyboard event forwarding now works better for plug-in windows. 
•  A benign problem that caused an error at startup: "the object for a history XML node can't be found" has been
fixed. 
•  Disallow de-activation of master and mixbus DSP. This fixes a howling feedback sound when the master bus is 
made inactive. 
•  When you split a stereo region into mono, they will now show up together in the region list. 
•  Menu item "Sync editor & mixer order" now works 
•  Fix GUI glitch when switching editor's mixer strip from stereo to mono channels 

IMPROVEMENTS
•  Mono audio files loaded into a stereo track will now play back on both channels. 
•  Reinstate the ALL group for editing. 
•  Rationalize track and range selection modes so they follow more established conventions. 
•  Automation correctly drops back to playback value when touch ends. 
•  Write mode should not pick up the underlying automation settings during a locate.
•  When editing automation, make sure the edits never affect the sound outside of the edit range. 
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•  You can now choose the "merge files" option when importing 2 same-length audio files, and they will import to
a stereo track.
•  Add a shortcut to /Volumes in the Open Session dialog. This makes it easier to find sessions on a removable
drive. 
•  Add a switch to turn OFF internationalization (for users that want OSX in their language, but Mixbus in English) 
•  Use the term 'Markers' instead of 'Marks', more consistently. 
•  Correctly use broadcast wave file timestamps when importing. 
•  Switch many instances of "Ardour" to "Mixbus" such as MIDI ports, etc. 
•  Dialog now makes clear that when you delete a track, the session will be saved. 
•  Apple plug-ins are no longer separated into more categories than other plug-ins. 
•  Reinstate some MISC options that were lost: 
•  Link Region and Track Selection 
•  Name New Markers 
•  Rubberband select snaps to grid 
•  Auto-analyze new audio 
•  Dragging a region to exactly time "zero" was fiddly, this has been made easier. 
•  It is no longer possible to delete a mixbus or the master bus. 
•  Default JACK ports to 512 instead of 128. 
•  Remove "JACK does monitoring" option which has no effect on OSX. 

KNOWN ISSUES
•  Sessions opened in 1.3, then re-opened in 1.2 may display the Mix buses in the wrong order.  Sound will be
correct, though.
•  Some users have reported problems with 1.3 using UAD plug-ins.  We have tested at the factory on a
G5+UAD1 PCI system, as well as an Intel UAD2 Solo system, and it works for us. 
•  The solo-ing error on the Mix buses (where soloing a mixbus still allows any 'direct' assignments to the master
bus to be heard) is still present in 1.3 
•  Some users report that fader automation starting at time "0" will cause playback to fail. 

Mixbus v1.2 (6707)

FEATURES
Show all tracks with regions under playhead:

Right-click the Track/Bus side panel, and you'll find a new option to show all tracks with regions.  Any track
with a region under the playhead will be unhidden.  Tracks without regions under the playhead will be hid-
den.  This is a nice editing convenience that helps you manage large sessions.

Save As:
In addition to Save and Snapshot, there is now a ¨Save As¨ function which creates a new snapshot in the
session, but differs from "snapshot" in that future Save commands to go into the newly-created snapshot.

Track templates:
Track templates can be stored by clicking on the track name and choosing "Save As Template".  Templates
can be recalled by choosing the template from the ¨Channel Configuration¨ selector when making a new
track/bus.

Language translation:
Mixbus now supports many different languages for menus and dialog text.  To select a different language on
OSX, use the “System Preferences->International->Language” dialog.  Supported languages include English,
French, German, Italian, Brazilian Portuguese, Spanish, Russian, Greek, Swedish, Polish, Czech, and
Norwegian.  (See the About page for translator credits)

Ardour Exchange compatibility:
Ardour Exchange is a third-party utility which allows you to import AAF session files into the Ardour/Mixbus
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Mixbus Website
http://mixbus.harrisonconsoles.com

Find common Mixbus support questions & answers at:  
http://mixbus.harrisonconsoles.com/mixbus/website/info.html#support

For Mixbus support inquiries please email:  
mixbus@harrisonconsoles.com

or chat with other Mixbus users and developers using IRC: 
http://webchat.freenode.net/?channels=ardour-mixbus

Harrison Consoles

1024 Firestone Parkway
La Vergne, TN 37086

615-641-7200 Phone
615-641-7224 Fax

Harrison Consoles Main Website
www.harrisonconsoles.com
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